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Installing Diamond Edition Software
Download the installation files.

Unzip the files at the computer on which you wish to install.

Run startup.exe – you can accept all the defaults (if you change the default destination folder, take 
note of it).

Once the installation is complete, you will need to run the Database Administrator tool to connect to 
an existing database or create your initial database.  While a shortcut will be available on the desktop, 
you will access the DBAdmin tool via the: 
Start Menu | All Programs | Diamond Edition | Tools | Database Administrator.

At the login window, click on the Configure button. If your company already has a database, you will 
point the program to that location (for instance N:\Data where “N” is a mapped network drive, and 
Data is a shared folder on the network). You will point to the folder just above the ODBC folder as the 
Common Directory. [You may need to consult with your company IT Dept for the Common Directory 
path, or you may be able to obtain it from the login screen of a computer already successfully running 
Diamond Edition Software.]

If you are running this program for the first time in your company, you can point to the location of your 
choosing for the Common Directory (on the network if you plan to share the database within your 
company, or locally on the computer’s hard drive if this is to be a stand-alone program & database).  
If this is the case, you will select next until you reach a list of missing tables at which point you will 
click on the checkbox next to “Fix All” (you will do this at two points during the DBAdmin process).  
When you click finish, you will have an empty database into which you can begin entering company 
and employee information.  You may need to enter an Activation Code to confirm your license.

If you have pointed DBAdmin to an existing database, you will select Next throughout the balance of 
the DBAdmin process.  If you receive any errors or are warned of database incompatibility, then you 
may not be pointing to the proper Common Directory location, or your database is of a different vesion 
than the program you have installed.  You will need to call us for further instructions if that occurs.

Upon completion of DBAdmin, you will be returned to the login screen.  You may hit Cancel to close 
this login window since you will still be in DBAdmin mode and will not need to launch that now that 
you have configured the program.

Launch the program from the shortcut on the desktop.  Log in with the User Name and Password 
provided to you by whomever administers the program for your company.  (New/blank database 
users can log in with Admin and no password to begin setting up the system.) 
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Continued on Next Page
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If you encounter an error trying to run the program (such as “Invalid Resource File” or “Cannot Update 
Cursor”), the following adjustments to User Access Control and/or Folder Permissions will need to be 
made:     [Please note that a network administrator or other IT person may need to participate in order to 
allow these changes or to fine-tune them to comply with your company’s security guidelines.]

Diamond requires that User Access Control (UAC) in Windows be set to “Never Notify” – this is done via 
Control Panel | User Accounts | Change User Account Control Settings. Drag the slider all the way down to 
the bottom, select OK, and then reboot the computer.

All users of the Diamond program on any particular computer will need Full Control at the application 
directory which would be C:\Program Files (x86)\SoftwareTech unless you changed the destination folder 
during the installation.  To set permissions, right-click on the SoftwareTech folder, select Properties, click 
on the Security tab – All Users should be given Full Control.

If you encounter an error during login (such as Invalid ODBC Connection or Invalid Path), then you may 
not have sufficient Network Privileges to access the shared database, or you may not have the correct 
path to the Common Directory specified.  Your company’s Network or System Admin should be able to 
resolve this for you.

If you encounter an error referencing missing dll files, Resource File Version Mismatch or Visual FoxPro 
Support Library, then you likely need to download the following and unzip it into your local 
Windows\SysWOW64 directory and/or where your Diamond Edition Software exe file is located: 
http://www.stisupport.net/support/VFPDLL.zip

Solutions to Common Problems 
During Installation or Launch

Remote Support is Available
We provide remote support via GoToAssist which allows us to connect to a computer at your location 
using an Internet connection.  Remote support sessions can be scheduled by calling the office at 
(540) 721-1000.  The computer to which we will connect must not only have Internet access, but also 
access to any shared network resources required (i.e. when the Common Directory is stored on a 
network server) as well as rights to allow the running of remote connection software.  What follows are 
directions for initiating a Remote Support Session with us.

Continued on Next Page
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Remote Support Continued
Please click on the following link to log in for remote assistance:

http://www.gotoassist.com/ph/softwaretech

The page displayed will look like this and you will need to fill in all three text boxes or you will generate an 
error. Please be sure we can identify you and your company by the names you choose.

Your Name:

Your Company Name: 

question 
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CCChhhaaapppttteeerrr   111   –––   IIInnntttrrroooddduuuccctttiiiooonnn   
 

This Manual Covers 
• Installing TimeKron and importing information from other database programs 

• Setting and maintaining timekeeping policy 

• Maintaining individual, department project and job records 

• Basic operation - recording punches, time sheets and notes 

• Producing reports 

• Utilities 

• Trouble shooting  

Installation and Setup 
For system requirements and installation instructions see Chapter 2 – Installation and Setup. 

Background Information 
To set up departments, project, and jobs, see Chapter 3 – Getting Started.  To customize employee policies which cover 
areas such as overtime, punch rounding and other punch options, see Chapter 11 – Employee Policies. 

Basic Operation 
To learn how to perform the most frequently used TimeKron functions, Chapters 4-10 demonstrate how to keep routine 
timekeeping records for each employee.  Chapters 12-14  cover additional tools which can help track timekeeping. 

Reports 
To see samples of the reports TimeKron can generate, see Chapter 16 – Reports. 

Utilities 
To review TimeKron Utilities, see Chapter 17 - Utilities 

Trouble Shooting 
For fast help with common problems, see Chapter 18 – Trouble Shooting. 

A Windows Program 
TimeKron runs under the Microsoft Windows Operating System.  This manual assumes that you know how to perform 
routine mouse and keyboard operations in this environment. 
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Conventions Used in this Manual 
In this manual, we put [square brackets] around keyboard keys you must press, such as function keys [F1], the [Tab] 
key, the [Enter] or [Return] keys.  Prompts (messages and labels TimeKron displays on screen) are shown with this 
typeface.  Information you enter into data fields is shown with this typeface. 
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CCChhhaaapppttteeerrr   222   –––   IIInnnssstttaaallllllaaatttiiiooonnn   aaannnddd   SSSeeetttuuuppp   
 

This chapter familiarizes you with the minimum and recommended system requirements necessary to run TimeKron. 

The Installation Procedure is covered in detail.  It leads you through the basic install steps and then follows with advanced 
setup procedures.  If you have questions concerning the installation or setup, do not hesitate to call Software Techniques’ 
Customer Support. 

System Requirements 
With your purchase of Timekron Diamond or Timekron SQL, your license defines a maximum number of 
employees.  Minimum system requirements are fine if you have 100 or fewer employees.  As the number of users 
grows, processing speed slows and you may wish to increase processor speed and/or memory size to recommended 
levels. 

 

Resource Minimum Recommended 

Hard Drive 

(local and network) 

500 Megabytes (MB) 2 Gigabytes (GB) 

RAM 1 GB 2 GB or higher 

Processor Pentium Pentium 

Processor Speed 1.2 GHz 1.8GHz 

Operating System Windows XP Windows XP / 7 

Database Server 

(SQL version only) 

MS SQL Server 2005 MS SQL Server 2008 R2 

   

Installation Procedure 
1. Make sure that your system meets or exceeds the minimum TimeKron System 

Requirements. 

2. Insert the TimeKron CD into the CD-ROM drive. 

3. If your system has the Auto Run feature set on, skip to Step 6.  Otherwise, click the 
Microsoft Windows  Icon. 

4. Click Run and the following screen will appear. 

 
Run Startup 
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5. In the Run dialog Command Line box, type d:\startup.exe and click OK.  If your 

CD-ROM has a different letter than “d”, substitute that letter for “d”.  For example, 
e:\startup.exe.  The following screen will appear. 

 

6. You may now install TimeKron.  Click Install TimeKron. 

The following screen will appear. 

 

7. Click Next to continue.  The following screen will appear. 

 

8. Enter Customer Information.  Click Next to continue and the following screen will appear. 



Chapter 2 - Installation and Setup 13 

 

The above screen will allow you to change the destination folder.  The Destination 
Folder is the folder where the TimeKron software will be installed.  Installing to the 
default folder is recommended. 

Note - The Destination Folder is where the software program is loaded.  This will be different than your 
Common Directory (discussed later in the Startup section of this chapter).  Also, the installation directory 
is not usually located on the same disk or computer where your main Data is located.  The software works 
best when installed directly on the client, to take full advantage of the nature of C/S architecture. 

9. After selecting an installation directory, click Next to continue the installation.  The following 
screen will appear. 

 

If you have made a mistake, you may go back and correct it at this time. 

10. If you agree with the information stated, click Install to continue.  The following screen will 
appear. 
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Install Shield will keep you abreast of its progress. 

When the installation has been completed, the following screen will appear. 

 

11. The installation is now complete.  Click Finish and you will be returned to the following 
screen. 

 

12. You are now ready to run TimeKron and setup your database connection. 

13. Click Close to continue. 
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Note – If the Common Directory has already been configured, skip to License Activation. 

Database Connection and Setup – SQL Version 
Only use this section if you are using the TimeKron SQL Server Edition.  If you are using TimeKron Diamond Edition, skip 
ahead to Database Connection and Setup – Diamond Version. 

 

1. Before continuing you will need to make sure that you work with your DBA to create an empty SQL database.  
Make sure that the database is large enough to support all your data.  Also make sure your DBA has given you a 
SQL account with the necessary security to create all the tables that TimeKron will create. 

Write down the SQL Server Name for reference _________________________________ 

Write down the SQL Database Name for reference _______________________________ 

Write down or memorize your SQL account User Name ___________________________ 

Note – TimeKron requires an account with SQL authentication.  This SQL account will be used by the 
application itself for accessing and updating the database and must have full administrative 
privileges.  

 (Also memorize your SQL account password) 

2. Next, work with your DBA to make sure you have a SQL connection from your client workstation.  The next few 
steps will help you help you complete the connection process.  It will be probably be best if your DBA assists you 
in the next few steps. 

Most SQL environments will require the SQL DBA to perform some of the database installation steps. 

Use the Database Administrator Tool for TimeKron to establish the SQL database connection and setup the 
database tables.  From the Windows start menu, click Tools-Database-Administrator. 

 

 
Selecting DB Admin mode from the Windows Start Menu 
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3. After starting TimeKron, you will be asked to review the license agreement. 

Be sure to read through the entire License Agreement: 

 

 If you agree with the terms of the license agreement, click .  If you do not agree, click 

.  Click OK to continue. 

4. If you clicked I Accept after installing TimeKron, the following login screen will appear. 

 

At this point you will be not be able to login.  The first thing you will need to do is configure your Common 
Directory and setup your ODBC Connection.  To do this click on Configure.  If the button says "Change" instead 
of "Configure" then you are in the wrong place.  You need to be running the DB Admin Tool first before running 
the main application. 

5. The first thing you will need to do is establish a common directory.  Your data will be stored in a SQL database, 
however, TimeKron still needs a common area to store common files that can be accessed by all users.  It is 
usually best to store this on a networked file server that is on the same network as your SQL database server. 
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 Note to the Network Administrator - The common directory serves as a central gateway for the application.  It 
contains graphical images, user defined absence icons, encrypted email configuration files, encrypted ODBC 
connection strings, and report templates as well as other common components shared by all users.  It is 
important for consistency that all users who are accessing the same database share the same Common Directory. 

 Select a common directory on a shared network drive or shared network resource, such as “\\MyServer\SQL 
Suite\Common\”. 

6. The next step is to connect to the SQL Server and create an ODBC connection. 

 

 

 Enter the name of the SQL Server and the SQL Database that you recorded earlier.  You will need to supply a SQL 
server account ID and password.  If you are not sure contact your SQL DBA.  You can test your connection by 
clicking on Test Connection.  Once you have made a successful connection, click on Next. 

7. At this point you will have the option of checking for updates on the Web. 

 

This step is not always necessary, but is probably a good idea.  In some instances where there has been a 
change to the database structure, you may have to check for and download an update.  If there are updates 
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available, they will be downloaded to the common directory.  Each workstation will update itself from the 
common directory.  Click Next to move on to the next step. 

8. After connecting to the SQL Database, TimeKron will automatically test the database for structural integrity.  If 
you have just installed the application, the database should be empty. 

 

 

 To create a new database or to repair an existing database with a broken database structure click on Fix All.  
TimeKron will automatically construct all the missing database components.  Once you have a working database 
structure, click on Next. 

9. The next step is to make sure that the data in the database is initialized for use.  At this juncture the data should 
be empty and will need to be created just like the database structure was created. 

 

 

 TimeKron can easily create an empty database for you.  However, if you already have a non-SQL version of 
SoftTime Diamond or TimeKron you can do a Total Import.  This is the best way to import data.  It will preserve 
all of your settings without having to set everything up from the beginning. 

If you would rather start from scratch with a blank database you can click on Fix All. 
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Database successfully created - DB Admin setup complete 

 Once the data is created the database administration setup is completed.  Click on Finish and you can return to 
the Database Administrator Logon screen. 

 

 
Return to Database Administrator Login 

 With everything completely setup you will now be able to access TimeKron from the icon on your desktop or from 
the Windows Start menu. 

Database Connection and Setup – Diamond Version 
Only use this section if you are using the TimeKron Diamond Edition.  If you are using TimeKron SQL Server Edition, check 
out the previous section, Database Connection and Setup – SQL Version. 

 

1. The next few steps will help you help you complete the connection process. 

Use the Database Administrator Tool for TimeKron to establish the database connection and setup the 
database tables.  From the Windows start menu, click Tools-Database-Administrator. 

 

 
Selecting DB Admin mode from the Windows Start Menu 
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2. After starting TimeKron, you will be asked to review the license agreement. 

Be sure to read through the entire License Agreement: 

 

 If you agree with the terms of the license agreement, click .  If you do not agree, click 

.  Click OK to continue. 

3. If you clicked I Accept after installing TimeKron, the following login screen will appear. 

 

At this point you will be not be able to login.  The first thing you will need to do is configure your Common 
Directory.  To do this click on Configure.  If the button says "Change" instead of "Configure" then you are in 
the wrong place.  You need to be running the DB Admin Tool first before running the main application. 

4. The first thing you will need to do is establish a common directory.  TimeKron needs a common area to store 
common files that can be accessed by all users.  This common directory will also be where your main database is 
stored.  It is usually best to store this on a networked file server. 
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 Note to the Network Administrator - The common directory serves as a central gateway for the application.  It 
contains graphical images, user defined absence icons, encrypted email configuration files, encrypted ODBC 
connection strings, and report templates as well as other common components shared by all users.  It is 
important for consistency that all users who are accessing the same database share the same Common Directory. 

5. This step will show you where your database will be stored in relation to the common directory.  It also shows the 
type of database used.  Click Next to go to the next step. 

 

 

6. At this point you will have the option of checking for updates on the Web. 

 

This step is not always necessary, but is probably a good idea.  In some instances where there has been a 
change to the database structure, you may have to check for and download an update.  If there are updates 
available, they will be downloaded to the common directory.  Each workstation will update itself from the 
common directory.  Click Next to move on to the next step. 
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7. After connecting to the database, TimeKron will automatically test the database for structural integrity.  If you 
have just installed the application, the database should be empty. 

 

 

 To create a new database or to repair an existing database with a broken database structure click on Fix All.  
TimeKron will automatically construct all the missing database components.  Once you have a working database 
structure, click on Next. 

8. The next step is to make sure that the data in the database is initialized for use.  At this juncture the data should 
be empty and will need to be created just like the database structure was created. 

 

 

 TimeKron can easily create an empty database for you.  However, if you already have SoftTime Diamond or 
TimeKron you can do a Total Import.  This is the best way to import data.  It will preserve all of your settings 
without having to set everything up from the beginning. 

If you would rather start from scratch with a blank database you can click on Fix All. 
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Database successfully created - DB Admin setup complete 

 Once the data is created the database administration setup is completed.  Click on Finish and you can return to 
the Database Administrator Logon screen. 

 

 
Return to Database Administrator Login 

 With everything completely setup you will now be able to access TimeKron from the icon on your desktop or from 
the Windows Start menu. 

 

License Activation 
1. Now you should be ready to run TimeKron for the first time. 

 

 

 

 

First time application login 

 To enter TimeKron for the first time, login in as Admin with no password.  Once you get in you can 
change your User Name and password.  If you did a Total Import you will be able to use the User 
Names and Passwords that were imported. 

2. Now you should be ready to activate your license. 
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Enter your activation code 

 Your CD and CD case should contain an Activation Code.  Simply enter the code and click on OK and 
you are ready to use TimeKron.  Once activated, your database will be locked into a maximum number 
of employees.  If your company exceeds that number of employees, you can contact your sales 
representative to purchase a license extension.  You will then receive a new activation code, which can 
be entered through the Upgrade License Utility. 

 Congratulations!  You are now ready to begin using TimeKron. 

Setting up additional workstations 
After the first workstation, each additional workstation is much easier to set up.  To set up additional workstations, you 
can enter the program normally (not in DB Admin mode).  Once in the program, you will get to a similar login screen: 

 

The Configure button has been replaced by the Change button.  In this case, click the Change button.  The following 
screen will come up: 

 

Just change the Common Directory field to what you set up in the step above.  Once you click OK, the workstation will 
inherit all the settings from the common directory.  Just click OK on the Login Screen and you’ll be in! 
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Now that you have installed TimeKron, you will want to configure the software to your specifications.  There are 7 areas 
that you should configure to setup your environment: 

• Super Administrator Options 

• Workstation Options 

• E-mail Configuration 

• Employee Policies 

• Project List  

• Job List  

• Department Roster  
 

Visit these sections in order for best results. 

System Roles 
In order to better understand which users have access to which options in TimeKron, it is helpful to cover the System 
Roles. 

Employee 
Employees generally have read-only access to their own information.  They can view their own calendars and reports.  In 
some instances, they may be granted additional privileges depending on their policy settings (see Chapter 11 – Employee 
Policies). 

Administrator 
The Administrator role is allowed to view and modify time records for a certain subset of employees.  This can be for one 
or more departments.  The Super Administrator sets their privileges. 

The Administrator role does most of the data entry into the TimeKron system.  They can access and modify all employees 
in their purview, but can not alter any global configuration settings.  

Super Administrator 
The Super Administrator has all privileges on the TimeKron system.  They can do everything an Administrator can do as 
well as set global configuration parameters and assigning Administrator roles and privileges.  The Super Administrator can 
also give users Super Administrator options.  

Super Administrators have access to all employees, all the time.  They also have access to all sections of the program.  
Super Administrators can log in as regular administrators if they want.  If you log on as a Super Administrator, the 
database will be locked and you will be the only one allowed to use the database at that time. 



TimeKron User Manual 26 

Database Administrator 
The Database Administrator is a special role that works outside of the TimeKron application.  This person is responsible for 
making sure that your Database is functioning properly.  This includes creating the database, making sure the database 
server is operating smoothly, making sure the TimeKron Database is secured and accessible by all those that need to 
access, and finally making sure it is backed up on a routine schedule. 

 

Feature (see menu) Employee Admin* SA (shared) SA (users locked out) 

Export  X X X 

Import    X 

Employee Policies    X 

Projects    X 

Jobs    X 

Departments    X 

Punch/Note 
Maintenance 

 X X X 

Time Sheet Approval  X X X 

In/Out Board X X X X 

Punch Station ** ** ** ** 

SA Options    X 

Email Configuration   X X 

Upgrade License    X 

Web Update    X 

Email Notification  X X X 

Employee Reports X X X X 

All Other Reports  X X X 
Security feature grid (X = access allowed) 

* – Read-Only Admin access is identical to regular Admin access, with the exception that a Read-Only Administrator 
cannot change data. 

** – All users can start and use the Punch Station.  However, the Punch Station can only be initialized and set up by a 
Super Administrator.  If the Punch Station has not been initialized, it cannot be used.  For more information regarding the 
Punch Station, refer to Chapter 14 – Punch Station. 
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Getting Around 
TimeKron is a standard Microsoft Windows application.  You should be familiar with concepts such as menus, clicking, 
double-clicking, drag & drop and therefore have no problem navigating. 

 

The default screen of TimeKron shows a list of employees and a form with 4 tabs: Time Sheets, Punch Records, Notes, 
and Employee Information.  Each of these tabs has their own section later in the document.  There is also a Department 
drop-down list box so you can filter your list of employees by department. 

 

 

TimeKron also depends on “menu navigation” to find some features.  Explore the menus.  Depending on your role in 
TimeKron, you will have access to some of the features.  The others will be disabled. 

 

 

TimeKron operates by interfacing with the database.  This is handled internally by the application as it communicates with 
the database Server.  The database Server can maintain several databases.  To make sure you are accessing the correct 
database you can always look at the application title bar.  If you are using the SQL version, it should include the name of 
the database in square brackets (e. g. [TSQL]).   

If the correct database does not appear in the title bar, exit the application and contact your Database Administrator. 

Employee Selector 
You can choose which employee to view by clicking their name in the list to the left.  You can filter this list by changing 
the Department dropdown and the Show terminated employees checkbox.  All information on the tabs to the right of this 
list will reflect data for the currently selected employee. 

 

Administrators can also add and remove employees from the list.  Employees can only view themselves.  Their list will only 
have themselves in it. 
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Read Only Access and Record Locks 
The first user to access an employee will place a lock on that Employee Information.  When the second user attempts to 
access the same employee at the same time he will only be able to access the Employee Information in Read-Only mode.  
This will prevent two users from changing the Employee Information at the same time.  When Employee Information is 
accessed in Read-only mode the Employee Information page title will display "[READ ONLY]" and the page will be a darker 
shade of grey. 

 

Security settings in the system can also create Read-Only mode.  Employee access has Read-Only access to their own 
information by default.  An administrator can also be set up to have Read-Only access to one or more departments.  In 
these cases, employees will come up as Read-Only whether or not another user is on that employee.  This Read-Only 
mode encompasses all aspects of that employee including time data entry and the screen title will display “READ-ONLY” 
next to the employee name and the screen will be a darker shade of grey. 
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Week Selector  
The main form in TimeKron always has to have a week range selected.  This week range is selected through the Week 
Selector located just above the Employee Selector.  You can scroll the week selector up and down weeks using the up and 
down arrows and even change the current month and year.  In the week selector, today’s date will be highlighted in red. 

 
Select a week 

Show In/Out 
The main In/Out board is discussed in more detail in Chapter 5 – In/Out Board.  The main screen, however, allows the 
In/Out status of the employees to be displayed right in the main form.  To see the In/Out status, click the 

 button on the main form.  You will then see the In/Out status of each employee appear next to the 
name. 

 

To hide the In/Out status again, just click the  button. 
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Super Administrator Options 
To enter this mode, click on Tools->Super Administrator Options.  This screen allows the Super Administrator to 
configure global settings that will apply across TimeKron.  

 

Options 
Work Week Starts – Here you can specify what day of the week your work week starts.  This setting affects all other parts 
of the application and should be chosen carefully. 

Cutoff Hours - TimeKron can record punches all day long.  When someone punches in and then punches out, TimeKron 
creates a punch record recording the start of the segment (Punch In) and the end of the Segment (Punch Out), and 
figures out the time of the segment.  However, TimeKron does have a limit in terms of how long it can create a time 
segment for.  For example, If someone punches in at 9:00 AM, but then punches back in again the next day at 10:00 AM 
(because he forgot to punch out in the evening), normally, that would create a 25 hour segment.  In TimeKron we put a 
limit on how large we can auto-create a segment of time.  If any punch out would exceed the cutoff hours the punch is 
still created, but the segment is not completed as normal.  Instead, we generate a Note explaining the excessive hours 
and leave the original segment open. 

Task Naming 
Throughout this manual we refer to both projects and jobs.  Those terms are used in order to classify time worked.  If 
your company uses a different terminology for projects and jobs, you can specify it here.  After you change it here, the 
terminology will be changed throughout the application.  Because we use both singular and plural forms of the words, we 
ask that you specify both.  

SoftTime Suppression 
If you are using SoftTime with TimeKron, TimeKron will automatically have access to SoftTime data and allow you to 
access some SoftTime data from within TimeKron.  If you wish to suppress this feature, just check this box.  

User-defined Punch Comments 
When punching in or out, each user has the opportunity to add a note as to where they are going or where they’ve been.  
TimeKron includes a section where you can customize some of the quick messages to suit your company.  Here in the 
Super-Administrator form, you can decide at which level you want the Punch Comments customized.  If you choose 
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Administrator, then the comments will be customized in one place for use by all users.  However, if you choose the 
workstation option, then comments will be customized for each workstation.  If you’ve selected Administrator, then you 
can click the Adjust… button. 

 

External Punches 
Check “Enable External Punch System” to enable the external punch system.  For more information see Chapter 15 – 
External Punch System.  If this is not checked then all external punches will be ignored. 

Company Info 
This information allows you to customize reports and printouts with your company name and logo. The name entered 
here will appear wherever a report or screen displays the company name.  Pressing the Get Company Logo button will 
present you with a file picker dialog to choose an image file for your company logo. Reports allow you to select a 
checkbox to display this logo on printouts. 

Workstation Options  
To enter this mode, click on Tools->Workstation Options.  These options apply only for the specific workstation on 
which TimeKron is running.  They govern certain settings that apply to the user’s session and display preferences. 

 

 

Low Resolution Reports 
This option allows you to specify that you have a lower resolution printer.  The report generator will forgo the fancier 
shading it uses when generating reports. 
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Case Sensitive Password 
This applies to the passwords for THIS WORKSTATION ONLY.  If it is set then anyone logging into this machine will be 
required to enter a case sensitive password.  

Tool Tips 
Checking this box will present you with a tool tip on the cursor wherever one is available in TimeKron.  This can be helpful 
when you are first learning the software and can be turned off after you are familiar with the program. 

Exit Warning 
This option will alert you any time TimeKron is closing to make sure you actually wish to end your session. 

Deletion Warning 
This option will confirm deletion any time you attempt to delete anything in TimeKron.  

Show Totals in HH:MM 
When this is checked, times in TimeKron will be shown in hours and minutes.  Otherwise, times will be shown in 
hundredths of an hour. 

Suppress Auto-Start 
TimeKron can be setup to launch when a user logs in to Windows.  This may be advantageous for some, but sometimes 
you might not want that to happen.  To suppress the Auto-start when a user logs in to windows from this workstation, 
just check this option. 

Adjust Punch Comments 
As discussed in the previous section, Punch comments can be established at the workstation level or at the administrator 
level.  If they can be adjusted at the workstation level, this button will be enabled and you will see a Punch Comments 
screen similar to the one from the Super Administrator options section. 
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E-mail Configuration 
To configure your e-mail settings, click on Tools->E-mail Configuration.  These settings are available to the Super 
Administrator ONLY.   

 

Enable E-mail Notification Check Box 
This is the first step to setting up your e-mail configuration.  When this box is checked all of the other settings become 
enabled.  Without e-mail notification enabled, TimeKron will not attempt to generate emails. 

Auto-detect Settings Button 
This handy button will go out onto the Super Administrator’s computer and detect the server and account that is set up in 
the default mail client.  It will present you with a confirmation dialog showing what it was able to detect. 

 

You can either accept the detected settings by pressing OK or ignore them by pressing Cancel. 
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Outgoing Mail Server 
This is the SMTP server name that handles your outgoing mail.  It can be found in the configuration settings of your mail 
program.  It is usually in the form “mail.yourcompany.com” or “smtp.yourcompany.com”. 

Administrator E-mail 
This is the e-mail address TimeKron will use to generate emails.  It must be a valid account on the specified mail server 
above.  This is also the account that will be notified if there is a problem sending e-mails. 

Administrator Name 
This is the name associated with the e-mail account above.  It will be filled in by the Auto-Detect or you can change it so 
the generated emails appear as if they come from a certain person in your organization. 

E-Mail Protocol 
Most TimeKron users should be able to use their e-mail server with the default protocol.  This is an internal TimeKron 
protocol known as "Protocol S".  In some rare instances, you may experience problems with your e-mail server settings.  
In these situations a certified Technical Support Engineer may suggest that you try using the alternate protocol "Protocol 
W". 

My Server Requires Authentication 
With security as a concern these days, most mail servers require authentication.  However, since this will be internal mail 
to employees, your mail server may not require it.  If you use Auto-Detect, it will be able to figure out your server’s policy.  
If authentication IS required, you must fill in the User Name and password fields below. 

User Name 
This is your E-Mail user name, not to be confused with your TimeKron login.  In some cases it is your full email address. 

Password/Confirm 
This is your E-Mail password.  You must enter it here twice.  Auto-Detect WILL NOT fill in your password. 

Test E-mail 
Once all the information has been entered, you can test to see if the information will work.  Click the Test E-mail button 
in the upper right.  If the E-mail was sent successfully, then you will be notified.  Otherwise, it will tell you why the e-mail 
did not send.  If the E-mail did send then go to your E-mail program and receive mail from the Administrator E-mail 
account.  If you receive the email, then you are all set. 

Default E-mail Subject 
This is the text that will appear as the default subject for generated email.  You can override this subject on the e-mail 
notification screen. 
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Employee Policies 
To enter this tool, click on Tools->Employee Policies.  Employee Policies allow you to set up policy categories that 
dictate how the system deals with employees.  Each policy has four sections:  Overtime, Rounding Rules, Punch Options 
and Other. 

 

To maximize TimeKron’s usefulness, these policies should be set up before you enter in any employees or start regular 
data entry.  For a more detailed description and an explanation of each option, check out Chapter 11 – Employee Policies. 

Project List 
To enter this tool, click on Tools->Projects.  The project list allows you to set up projects that your company will be 
working on.  Each time you enter in time either through punching or in the time sheet, you can specify a project for that 
time.   

 

Each project can have a code, name and description.  Each project needs at least a code or a name.  If you are using the 
External Punch System (see Chapter 15 – External Punch System), you may want to use a numeric code as it will be 
easier to enter in. 

To modify a project, just find the project in the list and click on it.  You can then adjust the other information.  You can 
have two or more projects with the same code and name, but it is not recommended. 

To create a project, click the Add Project button.  Then you just add in the code and/or name and description and that’s it. 
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To delete a project, click the Remove Project button.  If the project you are trying to remove is being referenced 
anywhere else in the system, you will not be able to delete it. 

Each project can also have jobs associated with it.  If you have a large number of jobs, associating certain jobs with 
projects can make data entry easier.  It is important to remember, though, that any job can be associated with any 
project. 

 

In this example from the Time Sheet, you can see how the job listbox lists the associated jobs before all the other jobs. 

To associate a job with a project, first select a project from the list on the left.  From the Job list on the right, you can click 

on a job and then the  button and it will be added to the Associated Jobs list.  You can also double click on the job 

and it will be added as well.  To remove a job from the Associated Jobs list click the  button or just double click the 
job. 

If you have one project that you want to have the same associated jobs as another project, you can click the  
button.  You will then see a list of all projects and their associated jobs: 

 

Just click the project you want and click OK.  You will then see the original project with the same jobs. 
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Job List 
To enter this tool, click on Tools->Jobs.  Used in conjunction with Projects, Jobs are used when recording time in 
TimeKron. 

 

Each job can have a code, name and description.  Technically, you don’t’ need to have either a code or name for a job, 
but it is recommended that you use one or both of those fields as a title for the job.  If you are using the External Punch 
System (see Chapter 15 – External Punch System), you may want to use a numeric code as it will be easier to enter in. 

To modify a job, just find the job in the list and click on it.  You can then adjust the other information.  You can have two 
or more job with the same code and name, but we don’t recommend it. 

To create a job, click the Add Job button.  Then you just add in the code and/or name and description and that’s it. 

To delete a job, click the Remove Job button.  If the job you are trying to remove is being referenced anywhere else in the 
system, you will not be able to delete it. 

Note – Projects and Jobs can be created on the fly by users with the appropriate policy privileges (see Chapter 
11 – Employee Policies). 

Department Roster 
To enter this tool, click on Tools->Departments.  The Departments screen allows you to add and remove departments 
and provide name and description information.   

You can also view which employees belong to which departments (this is set in the employee information tab).  This tool 
is only available to the Super Administrator.  

If you attempt to delete a department that has employees assigned to it, TimeKron will ask you to remove all references 
to the department before deleting it. 
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To access Employee Information, click on the right most tab of the main screen (Employee Info Tab). 

 

This screen defines personnel information concerning each employee. 

 

Administrators have either read-only or full access to information on this screen depending on their security level.  
Employees have read-only access. 

Add Employee 
Pressing the Add button at the bottom of the employee list will display the Add Employee screen.  Last Name and Hire 
Date are the only required fields, but you will most likely want to enter all the information that you have.  



TimeKron User Manual 40 

 

Remove Employee 
Clicking the Remove button simply removes the selected employee from the list and from the system.  All of their absence 
information will be deleted.  If you have Deletion Warning checked in the workstation settings you will be asked to confirm 
the deletion. 

 

Employee Information 
Since most fields are self explanatory, only the fields that require an extended explanation will be discussed. 

 

Hire Date 
Each employee is required to have a hire date.  

E-mail 
TimeKron supports E-mail notification.  
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Department 
A drop-down list of all departments is used to set this employee’s department.  Departments are maintained by the Super 
Administrator in the Departments screen under the Tools menu. 

Photos 
TimeKron allows you to associate pictures with each employee.  Just click the Find button and find the picture for the 
employee.  The picture can be in GIF, JPG, or BMP format.  To remove the picture press the Remove button. 

 
Find Photo 

Security Profile 
The Security options allow the Super Administrator to grant Administrator privileges to users managing departments and 
to assign which departments they have access to.  The Super Administrator can also grant Super Administrator access to 
another user. 

Administrators and Super Administrators can also change an employee’s User Name and Password.  Employees can view 
their own security setting (Employee Access), and can change their own password. 

 

 

Notice that an administrator can be given access to more than one department without being given access to all 
departments.  Also the administrator's privileges can be set at one of four levels.  Clicking on an empty check box will give 
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a blue checkmark, which grants the maximum level of access including the ability to receive administrative email 
notification.  If you click on the blue checkmark it will change to the green check mark.  This second level grants full read 
and write access, but the user will not be notified through administrative email notification.  Clicking a third time will 
change the checkmark to orange which grants access only to add or change time data, but not employee data.  Clicking a 
fourth time will change the checkmark to yellow, which will allow the user to view employee absence data for that 
department, but no access is given to add or change data.  If you click a fifth time the checkmark will be removed and the 
administrator will not have any access to that department. 

 

Default Project/Job 
TimeKron supports unlimited projects and jobs that can be associated with time.  It is likely, however, that each employee 
has a project and/or job that they use more than others.  If that is the case, then you can use the Default Project and 
Default Job fields to set it up.  These defaults will be handy when punching in and out. 

 

Policy 
Each employee will have a ‘Policy’ associated with them.  This policy will dictate how overtime, rounding rules, punches 
and other things will work for each employee in the system.  For a more in depth discussion of policies, check out Chapter 
11 – Employee Policies. 

 

Policy Overrides 
Once you have selected a policy for an employee, that employee retains all of the attributes of that policy.  Most of the 
time, this will work fine, but occasionally you may need to make slight adjustments to a policy for one or more employees.  
Instead of creating a whole new policy, you can use Policy Overrides.  To access Policy Overrides, click the [?] button next 
to the Policy field. 

You can override any or all parts of each policy.  To override an option, just click the override checkbox of the section you 
want to change and then select the option you want for that employee. 
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Here, Project/Job options have been overridden and Can Add Projects has been unchecked.  From now on, this employee 
would not be able to add projects even though the –Default Exempt Policy- would normally allow him to do it.  To undo an 
override, you just need to uncheck the section.  In this case you would uncheck ‘Override Project/Job options’.  The 
default values for that policy would then be back in place.  Fields in BOLD are overrides from the main policy. 

Exempt Status 
Each employee has an exempt status associated with them.  Normally, salaried employees would be classified as ‘Exempt’, 
while hourly employees are usually classified as ‘Non-Exempt’. 
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In an office setting where there are numerous people, it can be difficult to keep track of the comings and goings of every 
single employee.  For this reason, TimeKron has an In/Out board to tell you who is in and who is out.  The In/Out board 
can be accessed from the Quick Start Menu and it can also be accessed by clicking View -> In/Out Board.  The In/Out 
board will look like this: 

 

The In/Out Board tracks the punches of all employees and shows you their last recorded punch.  The information on this 
form should be self explanatory for the most part.  The Location column represents the location of the last punch for that 
employee.  Unless you are using external devices, the location will be the ‘name’ of the computer where that person 
punched.  The Details part of the Details/Comments column usually represents the Project and Job that was punched into.  
The Comments part represents any notes that the employee entered with the punch.  In the lower left part of the form is 
the current time.  The Refresh button will do an immediate Refresh of all employees in the board. 

This In/Out board is also customizable.  The board as you see it now has all features activated.  To change the look of the 
In/Out board, click the Setup button. 

Setup 

 

Employee Selection 
The employees displayed in the In/Out board are customizable.  Here, -All Departments- are shown.  In the same way, 
you can choose one or more departments to display or even switch over to the employees and choose one or more 
employees to display.  
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Name Option  
The Name option determines how names in the In/Out board will appear.  Regardless of the other options, the employee’s 
name will always appear in the In/Out board.  Here, you choose to display employees’ names as ‘Last, First’, ‘First Last’ or 
‘Initials (only the employees’ initials are shown)’ 

Display Options 
The Display options can further limit what is in the In/Out board.  The first four options represent potential columns in the 
In/Out board.  If you don’t want to see the punch Time, Comments, Details or Locations, just uncheck the appropriate 
box.  The last three options can limit the employees viewed.  If you don’t want employees that are ‘out’ to appear in the 
list, uncheck the last option. 

Refresh Rate 
The Refresh rate determines how often the In/Out board will automatically refresh.  The default is set to 30 seconds.  
That means that every 30 seconds, the In/Out board will automatically refresh.  You can set the refresh interval anywhere 
from ‘10 minutes’ all the way down to ‘Never’. 

Once you have selected the options you want, click OK to return to the In/Out board.  If you’ve made changes in the 
setup form, you should see those changes reflected.  It could look something like this: 

 

Form sizing and form memory 
Another feature worth noting is that the In/Out board can be sized to fit your needs.  If you want to make it wider or taller 
you can do that by clicking on the form border and stretching or shrinking it.  Additionally, the In/Out board will remember 
how you sized it as well as where you moved it to.  The next time you go in to the In/Out board, it will be the same size 
and in the same place that you left it. 

Punching In and Out 
Another feature of the In/Out board is the ability to punch employees in and out.  If you want to punch an employee ‘in’, 
just click the button in the ‘In’ column and likewise, if you want to punch and employee ‘out’, click the button in the ‘Out’ 
column.  For more information on punching in and out, check out Chapter 6 – Punching In and Out.  The employees that 
you are allowed to punch in and out depends on your security profile. 
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For most companies, accurately tracking employee’s hours worked is essential to ensuring that the payroll is done 
correctly and efficiently.  An important part of that is tracking when your employees are ‘on the clock’.  In TimeKron the 
main way of tracking time is through the process of Punching in and out.  Punching in and out in TimeKron is somewhat 
similar to punching in to a punch clock.   

What is Punching In and Out? 
Punching in and out is the process whereby an employee records when they are working and ‘on the clock’ as well as 
when they are not working or ‘off the clock’.  When an employee gets to work, they would likely punch ‘in’ and when they 
leave for the day or even leave for lunch, they would punch ‘out’.  Another way that punching in and out is used is to track 
what each employee is working on.  If tracking time on specific projects is important during the day, you can punch from 
one project to another.  This would accurately track time worked on each specific project.   

What is working out of office? 
In TimeKron the two main punching statuses are ‘In’ and ‘Out’.  ‘In’ is represented by a green dot and ‘Out’ is represented 
by a red dot.  There is another status that can also be used.  It is called ‘Work’ status and is represented by a yellow dot.  
‘Work’ status means that an employee is currently ‘on the clock’, but is not at the office.  The yellow dot will appear in 
place of a green dot in the In/Out board.  With the exception of how it appears in the In/Out board, Punch ‘Work’ and 
Punch ‘In’ are identical. 

Other ways of punching in and out 
In this chapter, we will discuss how to punch in and out using TimeKron.  While this is the main way in which TimeKron 
accepts punches, it is not the only way.  TimeKron also has the ability to read punches from external hardware as well as 
other sources.  For more information on this, refer to Chapter 15 – External Punch System. 

Where to punch in/out from 
There are several different ways that you can punch in and out using the TimeKron software.  Probably the most common 
way is to do it through the Quick Start menu.  The Quick Start menu allows you to quickly punch in and out from your 
workstation desktop.  For more information, refer to Chapter 13 – Quick Start menu.  Another way to punch in is through 
the In/Out board.  The In and Out columns can be clicked to allow quick access to punching in and out.  For more 
information, check out Chapter 5, In/Out Board.  Finally, you can also punch in and out through the punch station.  
Punching in and out through the punch station works in the same way as the In/Out board.  For more information on the 
Punch Station, refer to Chapter 14 – Punch Station. 

Punching In 
When you punch ‘In’ through TimeKron, the form will look like this: 
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The form caption at the top shows the name of the person who’s punching in. 

 

The field at the top of the form shows the current In/Out status and last punch of the current user. 

 

Rounding 
Next is the rounded and actual times that the user is about to punch with. 

 

On the right side in larger characters is the actual time.  The field on the left is the time that will be used to punch with.  
This time may represent a rounded time if this employee is set up with rounding rules.  The user may also be able to 
manually adjust the time using the drop-down list box, if they are allowed to adjust their own punches through Employee 
Policies.  For more information on Rounding rules and manually adjusting punches, refer to Chapter 11 – Employee 
Policies. 

Projects/Jobs 
The next section is where a user can enter in a project and job to punch in to. 

 

Here the employee can specify what project and/or job they are punching in to.  They can select from any project or job 
in the ListBox.  Additionally, if they have rights through Employee Policies, they can add projects and jobs on the fly.  Also, 
for quick reference, you can click the ‘?’ button to see the recent punches for that employee. 
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This form will list the 5 most recent punches for the employee.  To select one of these for the current punch, just click the 
button. 
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Comments 
At the bottom of the Punch In form is the Comments. 

 

Many times when an employee punches in or out, they may want to include a note as to where they are going or where 
they’ve been.  Here is where you would put that note.  You can type anything you want in the field here.  Additionally, you 
can choose from pre-selected notes by clicking on the ‘?’ button. 

 

Just click the button of the comment you want to post and that’s it! 

Punch Work 
Another aspect of the Punch In form is the ability to punch in to ‘work’ status.  This is done by checking the checkbox at 
the bottom of the form. 

 

After you check the checkbox, the button above will change to yellow signifying the ‘work’ status.  This will only effect the 
way the status appears in the In/Out Board. 
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Punch Out 
At the end of the day, it’s time to punch out.  In TimeKron the punch out form looks like this: 

 

In many ways, this form works in the same way the punch in form does.  The name is still at the top.  The current 
employee’s In/Out status and time are listed at the top as well.  The two times shown are still the rounded time and actual 
time and the user may still have the ability to adjust the punch out time.  The In/Out Comments work the same way as in 
the Punch-In form.  Finally, the Punch-Out button completes this function. 

Network Time vs. Local Time 
An important concept in TimeKron is time normalization.  In an office setting with numerous workstations, the times on 
each workstation can vary.  Under normal circumstances, this can cause problems for keeping accurate track of time.  In 
TimeKron, we want every punch from every workstation to be using the same time.  We do this by using the time from 
the database server for every punch rather than the local time on each workstation.  This helps to normalize all the times 
for all the employees. 
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For those employees who do not have to punch in and out to record time, they will most likely have to fill out a time sheet 
to account for their hours.  In TimeKron, the Time Sheet is the centerpiece for displaying time. 

Time Sheet Grid 
When you start up the main TimeKron application the first thing you will see is the Time Sheet Grid. 

 

What is Time Sheet Data? 
The Time Sheet Grid can be used to enter in the hours worked for each day of the week.  Totals are grouped by Project 
and Job.  Punch records will appear in the Time Sheet Grid as well but cannot be edited from this interface.  The punch 
record data will be consolidated under project/jobs for each day.  Both punch records and time sheet records will be used 
to calculate work and overtime totals. 

 

Time Sheet Navigation 
Once you click in the time sheet you can move the cursor around using the arrow keys such as in a spreadsheet.  Adding 
a row to a time sheet is pretty simple.  Just click on a row and start entering in time.  Technically, you don’t even have to 
specify a project or job.  Deleting a row in the time sheet is a little more difficult.  Because each row represents 7 days 
worth of data TimeKron does not offer a single button to remove the entire row.  For each day of data that you want to 
remove, you will have to go to that cell in the time sheet and delete the value.  This allows you to delete only the data you 
want and avoid deleting time unnecessarily.  If all time in a row has been deleted, the entire row will be deleted once you 
save the time sheet.  Modifying time sheet rows is simple as well.  If there is data on a time sheet row that needs to be 
adjusted, just click in the cell and make the change.  After the time sheet is saved, the change will take effect.  One thing 
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to keep in mind with regard to adding, deleting and modifying time sheet data is that it applies only to time sheet records 
and does not apply to Punch Records.  The difference between time sheet records and punch records will be discussed in 
the next section. 

 

When you first open a time sheet for a week, these buttons will be disabled.  Once you start making changes to the time 
sheet, they will become enabled.  Once enabled, you can choose to either discard any changes you’ve made or Save the 
changes.  After clicking Save, these buttons will become disabled again.  If these buttons are enabled and you change 
either the week or the employee, the data will automatically save. 

Grid Icons 
If you haven’t already noticed, the column on the far left contains an icon for each row.  These icons represent what type 
of row it is.  In the time sheet grid, there will be three different kinds of grid icons. 

 Time Sheet   

This icon represents a time sheet row.  These rows are editable. Note that the text in this row is normal (not italicized.) 

 

 Punch Record   

This icon represents a punch record row.  These rows are not editable.  The text in this row is italicized meaning that it 
cannot be edited.  Anytime you see italicized text in TimeKron, it means that the data is read only. 

 
 
SoftTime Data 

This icon represents absence data from SoftTime.  These rows are also not editable.  These icons will vary slightly 
depending on the category being reported.  The icons will be represented by a single letter with varying background 
colors. 

 

Grid Colors 
If you use the Submission/Approval process (see Chapter 12), then you will soon notice different colors on the time sheet.  
The default color of a time sheet is white which signifies the status ‘Not-submitted’.  Once you have submitted a time 
sheet and the status has been changed to submitted, the time sheet color will change to light blue. 

 

Notice that after a time sheet has been submitted, ALL records are now in italics and therefore read-only. 
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After a time sheet is approved, the time sheet color will turn into light green. 

 

Totals 
Each time sheet has an expandable totals section.  The default is that the totals section will be collapsed to make more 
room for time sheet records. 

 

The basic totals have totals for each day of the week as well as a weekly total on the right.  The expanded totals section 
can break down time in terms of regular and overtime.  To see the expanded totals section, click the up arrow button to 
the right of the totals row.  Once you click it, you will likely see something that looks like this: 

 

This view shows you how overtime breaks down for each day as well as the week.  For more information on overtime, 
check out Chapter 11 – Employee Policies.  To collapse this section, just click the down arrow button to the right of this 
section. 

Show SoftTime Data 
 

A powerful feature of TimeKron is its ability to be used in conjunction with SoftTime, our absence tracking software.  
When the two are used together, each program can access data from the other.  In this case, we can view absences in 
SoftTime right in the time sheet grid. 

 

In this instance, a late day was recorded in SoftTime on 12/6.  Note that absences in SoftTime are recorded in both hours 
and days.  Those type will also be reflected here.  In this case, ‘1 D’ represents 1 day. 

If you have Show SoftTime Data checked, you will also see a SoftTime totals row at the bottom of the time sheet. 

 

This row will only total up the SoftTime data.  SoftTime data is totaled separately and therefore has no effect on overtime 
calculations. 
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Show Time in HH:MM 
 

Time shown in TimeKron can be displayed in hundredths of an hour or in hours and minutes. 

 

Hundredths of an hour 

 

Hours and minutes 

Submission/Approval Process 

 

On the bottom left part of the time sheet page are the submit and approve buttons.  Actually, these buttons not only can 
submit and approve time sheets, but they can also un-submit and un-approve time sheets as well.  TimeKron will 
determine what each button does based on the time sheet itself and the policy settings of the currently logged on user.  If 
the current user is not allowed to submit or approve time sheets, these buttons will be disabled.  For more information on 
the Submission/Approval process, see Chapter 12 – Submission and Approval. 

Other Time Sheet Data 
One of the basic concepts of Time Sheets is the entire Submission/Approval process.  An employee fills out their Time 
Sheet for the week and submits that time sheet to an administrator who then reviews the time sheet.  The Administrator 
can then decide to approve the time sheet or, if they find a problem with it un-submit the time sheet and send it back to 
the employee for review.  Another possibility is that an employee’s time sheet might not be submitted by the employees 
themselves.  A brief display shows the current status of the time sheet. 
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This display can be expanded by clicking the down arrow button. 

 

Right now, this section doesn’t show any data, but after a time sheet has been submitted and approved, it may look 
something like this: 

 

Print 

 

This button appears on each of the Time Sheet, Punch Record and Note pages.  It will allow you to instantly print the 
information you see on the page in front of you. 

FYI 

 

This is another option that will appear if you are using SoftTime in conjunction with TimeKron.  The FYI button will bring 
up the FYI section that you would normally only see through SoftTime. 

 

This form shows you a synopsis of the current employee’s absence data for their current recording year. 
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Another way to view time is through the Punch Record grid.  Like the Time Sheet grid, the Punch Record grid will display 
both punch records and time sheet records.  Unlike the time sheet grid, the punch records grid will allow you to edit 
individual punch records. 

Punch Record Grid 
On the main form, the second page is the Punch Records page. 

 

What is a Punch Record? 
Generally speaking, punch records are created when employees punch in and out.  An employee punching in will create 
the start time of the punch record and punching out will create the end time.  The difference between punch records and 
time sheet records is that punch records have specific start and end times.   

Punch Record Navigation 
Once you click in the punch record grid, you can move the cursor around using the arrow keys much as in a spreadsheet.  

Adding a row to the punch record grid is as simple as clicking a button.  Just click  and you will see a form 
that looks like this: 

 

The date and start time default to the current date and time.  However, you can change those to be whatever you want.  
You can fill in as many fields as you need.  This includes the end time field.  You can add a punch record with a start time 
but no end time.  Once you’ve added in the data, click the OK button and the punch record will be added.  Note that if 
you’ve changed the date to something that exists outside the date range you were viewing, a warning message will come 
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up and tell you.  If you decide to add it anyway, you will see the record in the grid immediately after even though it 
doesn’t exist in that date range.   

Deleting a punch record is considerably easier.  The  button on the right will delete the entire record. 

Modifying punch records is simple.  Just click on a punch record and you can change the start time, end time, project and 

job.  The date on punch records is read-only.  Once you start making changes on a punch record a  button will appear 
on the right.  This is the discard button.  If you have made a change to a punch record and wish to revert the record to its 
original state, just click this button.  As far as saving punch record data is concerned, the changes you make will be saved 
once you move off the record. 

Grid Icons 
In the same way as the Time Sheet, the column on the far left contains an icon for each row.  These icons represent what 
type of row it is.  In the punch record grid, there are 8 different kinds of grid icons. 

 Time Sheet  

This icon represents a time sheet row.  These rows are not editable. The text on these rows are italicized to symbolize 
read-only data. 

 

 Complete Punch Record  

This icon represents a completed punch record.  These rows are editable. 

 

 Open Punch Record  

This icon represents an open punch record.  An open punch record is one that has a start time but no end time.  These 
rows are editable. 

 

 Overlapping Punch Record  

This icon represents an overlapping punch record.  An overlapping punch record is one where the start and end time 
overlap with another punch record’s start and end time.  These rows are editable. 

 
 
SoftTime Data 

This icon represents absence data from SoftTime.  These rows are not editable.  These icons will vary slightly depending 
on the category being reported.  The icons will be represented by a single letter with varying background colors.  This data 
will only be displayed if ‘Show SoftTime Data’ is checked. 

 

 Punch In Record  

This icon represents a punch In.  These rows are not editable.  This data will only be displayed if ‘Show In/Out Data’ is 
checked.  A Punch In record represents the event of someone punching in but has no duration. 
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 Punch Out Record  

This icon represents a punch Out.  These rows are not editable.  This data will only be displayed if ‘Show In/Out Data’ is 
checked.    A Punch Out record represents the event of someone punching out but has no duration. 

 

 Punch Work Record  

This icon represents a punch Work.  These rows are not editable.  This data will only be displayed if ‘Show In/Out Data’ is 
checked.    A Punch Work record represents the event of someone punching in but has no duration. 

 

Grid Colors 
If you use the Submission/Approval process (see Chapter 12), you will soon notice different colors on the punch records 
grid.  These colors are tied to the time sheet process.  Once time sheets are submitted and/or approved, you will notice a 
change to the color of certain records in the punch records grid.  The default color of a punch record is white which 
signifies the status ‘Not-submitted’.  Submitted records will be blue. 

 

Approved records will be light green. 

 

View by week or day 
Normally, the punch record grid views records for an entire week, much like the time sheet does.  On the punch record 
grid though, you can narrow the view down to a single day. 

 

Normally, the large button on the left is selected, but if you want to view a specific day of the selected week, just click the 
appropriate button and the view will be narrowed for just that day. 
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Show SoftTime Data 
 

A powerful feature of TimeKron is its ability to be used in conjunction with SoftTime, our absence tracking software.  
When the two are used together, each program can access data from the other.  In this case, we can view absences in 
SoftTime right in the punch record grid. 

 

In this instance, a late day was recorded in SoftTime on 12/6.  Note that absences in SoftTime can be recorded in either 
hours or days.   

Show Time in HH:MM 
 

Time shown in TimeKron can be displayed in hundredths of an hour or in hours and minutes. 

 

Hundredths of an hour 

 

Hours and minutes 

Show In/Out Data 
 

Another option on the punch grid, is to display In/Out records.  When In/Out records are displayed, they will be displayed 
down to the second. 
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Print 

 

This button appears on each of the Time Sheet, Punch Record and Note pages.  It will allow you to instantly print the 
information you see on the page in front of you. 

FYI 

 

This is another option that will appear if you are using SoftTime in conjunction with TimeKron.  The FYI button will bring 
up the FYI section that you would normally only see through SoftTime. 

 

This form shows you a synopsis of the current employee’s absence data for their current recording year. 
 

 



Chapter 9 – Notes 65 
 

CCChhhaaapppttteeerrr   999   –––   NNNooottteeesss   
 

A feature that can help to track the details of time worked is the Notes feature.  Employees can enter notes into TimeKron 
at any time.  There is no limit to the number of notes for a single day. 

Note Grid 
On the main form, the third page is the Notes page. 

 

What is a Note Record? 
Notes are usually created in one of two ways.  First, a note can be added directly.  The user can enter in the date and 
time of the note.  Secondly, notes are automatically added when comments are entered punching in or out.  In this way, 
the date and time are the same as the punch.  Notes added in this way can be viewed as part of a punch or as a note.     

Note Record Navigation 
Once you click in the note grid, you can move the cursor around using the arrow keys much as in a spreadsheet.  Adding 

a row to the note grid is as simple as clicking a button.  Just click  and you will see a form that looks like 
this: 

 

The date and start time default to the current date and time.  However, you can change those to be whatever you want.  
After that, you just need to enter in your note.  Once you’ve added in the data, click the OK button and the note will be 
added.  Note that if you’ve changed the date to something that exists outside the date range you were viewing, a warning 
message will come up and tell you.  If you decide to add it anyway, you will see the record in the grid immediately after 
even though it doesn’t exist in that date range.  
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 Deleting a note is considerably easier.  The  button on the right will delete the entire record.   

Modifying notes is pretty simple.  Because of the nature of note records and that most notes can’t fit in the grid, notes 

cannot be edited directly in the grid.  Instead, you need to click on the  button to the left of the record you want to 
edit.  That will bring up a form that looks like the one shown above.  You will then be able to edit the note as well as the 
date and time.  To save the changes, just click the OK button and you will see the changes reflected in the grid. 

Grid Icons 
In the same way as the Time Sheet, the column on the far left contains an icon for each row.  These icons represent what 
type of row it is.  In the notes grid, there are 2 different icons. 

 Note record  

This icon represents a note from TimeKron. 

 

 SoftTime Note Record 

This icon represents a Note Record from SoftTime.  These notes are not editable.  These notes will only appear when 
‘Show SoftTime Data’ is checked. 

 

View by week or day 
Normally, the note grid views records for an entire week, much like the time sheet does.  On the note grid though, you 
can narrow the view down to a single day. 

 

Normally, the large button on the left is selected, but if you want to view a specific day of the selected week, just click the 
appropriate button and the view will be narrowed for just that day. 

Show SoftTime Data 
 

A powerful feature of TimeKron is its ability to be used in conjunction with SoftTime, our absence tracking software.  
When the two are used together, each program can access data from the other.  In this case, we can view notes from 
SoftTime right in the punch record grid. 

 

In this instance, a note was entered in SoftTime on 12/12.  One thing to remember about notes from SoftTime.  Those 
notes have a date but not a time.  The reason for this is that in SoftTime, only one note is allowed per day.  Also note that 
these notes cannot be edited here, but only viewed. 
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Print 

 

This button appears on each of the Time Sheet, Punch Record and Note pages.  It will allow you to instantly print the 
information you see on the page in front of you. 

FYI 

 

This is another option that will appear if you are using SoftTime in conjunction with TimeKron.  The FYI button will bring 
up the FYI section that you would normally only see through SoftTime. 

 

This form shows you a synopsis of the current employee’s absence data for their current recording year. 
 

 



Chapter 10 - Punch/Note Maintenance 69 
 

CCChhhaaapppttteeerrr   111000   –––   PPPuuunnnccchhh///NNNooottteee   MMMaaaiiinnnttteeennnaaannnccceee   
 

The main screen allows you to move from employee to employee and view their hourly data and notes.  This is fine if you 
are only interested in one employee at a time.  If you want to view the hourly data or notes for more than one employee 
at a time, you can use the Punch Maintenance Form. 

Punch Grid 

 

Punch Navigation 
In many ways, this form is just like the main Punch Records page.  With the exception of the Employee’s name, the data 
is the same.  The icon to the left of the employee’s name allows you to change the employee’s record.  The criteria at the 
bottom determines what is shown in the grid.  The date range on the right works the same way as the one on the main 
screen.  The employee selector on the left works a little differently, however. 

With Employees selected ( ), you can choose one employee at a time.  Or, if you hold down the SHIFT or 
CTRL keys, you can select multiple employees.  When you select multiple employees, all their data will appear in the grid. 

 

With Departments selected ( ), it works pretty much the same way.  You can select a department and every 
employee in that department will be displayed.  You can even select multiple departments in the same way you select 
multiple employees. 
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Punch Grid Options 

 

The options “Show In/Out Data”, “Show SoftTime Data”, and “Show time in HH:MM” work in the same way as those in 
the Punch Records page of the main form.  Conversely, Time Sheet data will only be shown if “Show Time Sheet Data” is 
checked. 

For more information, refer to Chapter 8 – Punch Records.   

Note Grid 

 

In the same way as the Time Sheet, the column on the far left contains an icon for each row.  These icons represent what 
type of row it is. 

Note navigation 
Navigation on this page works just like it does on the Notes page on the main form.  It works much like a spreadsheet. 

Additionally, the employee and date criteria for this portion work exactly as it does for the Punch Record portion.  See the 
example above. 

Note Grid Options 

 

The options here work in the same way as those in the Notes page of the main form.  For more information, refer to 
Chapter 9 – Notes. 
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There are a number of features in TimeKron and potentially hundreds of employees that could be accessing those 
features.  To govern the use of these features by the employees, we have Employee Policies.  Employee Policies cover 
options from overtime to punch rounding to some minor security options. 

Basic Information 

 

These policies are broken down into four different sections.  TimeKron comes with two fixed policies that you can adjust to 
your liking, but they cannot be renamed or removed.  The two fixed policies are –Default Exempt Policy- and –Default 
Non-Exempt Policy-.  You can add as many policies as you need over and above these two. 

Employee Policies are accessible only by a Super Administrator in exclusive mode. 

Also, if you try to remove a policy that is currently in use, you will not be able to.  You will need to make sure that the 
policy you want to remove isn’t being used by any employee. 

Overtime 

 

TimeKron offers each employee up to four different overtime settings.  Overtime settings are not a necessity for each 
employee, but here is where you can set it up if you need it.  Each overtime setting offers an amount for both daily and 
weekly overtime as well as a rate. 

 

TimeKron will apply each overtime setting as necessary to each employee’s regular time.  Each successive Overtime level 
after the first needs to have daily and weekly hours that are equal to or greater than the previous level.  Each level’s 
overtime will be figured from the highest to the lowest level. 
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An example of how the overtime might be figured with this setup: 

 

You can see here that the numbers in red represent overtime amounts.  The amount of overtime for each overtime level is 
totaled at the right.  This is one way to figure overtime between days and hours.  The other way depends on the following 
setting: 

 

If this is not checked, overtime will be figured as it is above.  If it is checked, then the daily overtime amounts will be 
deducted from the weekly overtime amounts and you will get some different OT information: 

 

It is up to you as to which setting will better suit your company.  Generally speaking, most companies would go with the 
second option and deduct daily overtime from weekly overtime. 
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Rounding Rules 

 

To make figuring out time worked easier, some companies institute rounding rules that affect the times that employees 
punch in and out.  They may want a punch at 8:58 AM or even 9:02 AM to be 9:00 AM.  In TimeKron you can set up 
rounding rules for individual employees through this policy section.  When you set up punch rounding rules, each punch’s 
actual punch time may not be the effective punch time.  For example, if you want punches to round to the nearest 5 
minutes, then a punch in at 9:02 AM would be recorded as 9:00 AM and 9:08 AM would be recorded as 9:10 AM.  In 
TimeKron we give you nine possible ways to round time.  From one minute all the way up to 30 minutes.  One minute 
rounding is the same as no rounding at all as it will round each punch to the nearest minute.  Just select the rounding 
increment from the list.   
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When you select something from the list other than 1, you will have the option to set the rounding offset.  The rounding 
offset is useful if you want the rounding to be slightly different.  In any case, when you choose a rounding increment or 
change the offset rounding, the small text below will explain how the rounding will be affected: 

 

Punches 

 

Punch Options 
When punching in, TimeKron has two different ways of doing that.  The “Regular” punch method allows the user to enter 
in a project, job notes and lets them optionally set the punch time when punching in or out.  The “Quick” punch method is 
just that.  When you want to punch in or out, you click one button and that’s it!  TimeKron sets the time and uses the 
employee’s default project and job.  Here you can set which methods you want your employees to use.  You can allow 
both or you can restrict access to one or the other.  If you want your employees to punch in and out but don’t want them 
to use projects and jobs, then you would check “Allow Quick Punch In/Out” and uncheck “Allow Regular Punch In/Out” 

Logon Options 
Normally, whenever someone logs on to TimeKron, they would have to enter in a User Name and Password.  Using the 
logon options, you can streamline that process for employees so that they no longer need to enter a User Name and 
Password.  To activate this feature, check “Remember logon between sessions”.  

Once this option is activated, you will need to decide how the user will be recognized.  Before we can do this we need to 
talk about a term called ‘tokens’.  In TimeKron, a ‘token’ is how TimeKron recognizes each user that is logged on to the 
computer.  Here you choose one of 3 different token types: 

1.  Computer Name and User – Most strict method.  If this is selected, the employee will only be recognized if they are 
using a specific computer and are logged into Windows with a specific user name.  This is ideal if multiple employees are 
sharing a single computer.  

2.  Computer Name Only – this option will associate just the computer name to a specific employee.  Anyone using that 
computer will log on as the associated employee.  This is ideal for employees that work from the same computer all the 
time and do not share it with other users. 
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3.  User only – If your company has several workstations and users can log in and out of each workstation, you may want 
to choose this option.  This option will associate a specific user name to an employee.  When that user tries to log on to 
TimeKron from any workstation, it will recognize the user and log on as that employee.  This is ideal for users who log in 
to a network domain when starting Windows. 

The next time the user logs on to TimeKron, the ‘token’ association will be set.  From that point on, the login screen will 
be bypassed and the employee will automatically be logged in. 

You can manually create the ‘token’ association for individual employees if you don’t want to wait for them to log in for 
their first time.  This is done from the main Employee Information page.  Access the policy override for the employee by 
clicking the [?]. 

 

Select the Punch Option tab. 

 

In the above example the Token Type is User and the associated Token ID is “Gary” 

To manually set a ‘token’ association, click Change. 

To reset the association, Click Clear.  The Token ID will then read “-Auto Detect-” to indicate that it will automatically 
remember the ‘token’ association the next time the user logs in. 

 

When a user with a ‘token’ association exits TimeKron, they will have the option to uncheck “Remember Log On” 

 

This will close TimeKron and log them out so that another user can log in.  Next time the employee logs into TimeKron 
they will once again be remembered. 

In some circumstances you may not want the employee to have the option to uncheck “Remember Log On”.  If this is the 
case, then you will want to check the “Lock logon between sessions” option.  This will prevent the user from un-checking 
“Remember Log On”.  The option will still appear for administrative reasons but the user will be required to enter a Super 
Administrator User Name and Password before they will be allowed to Log Off. 

Auto-punch options 
Most of the time a punch ‘in’ or ‘out’ is a conscious act done through TimeKron’s punch clocks or some external punch 
clock.  In some instances, though, you may want to coordinate your punching in and out with your activities on your 
computer, or more specifically your activities on TimeKron.  These two options will punch an employee in whenever they 
start up TimeKron or it could also automatically punch them out when they exit the application.  This can save a few 
keystrokes or mouse clicks as your first and last punches of the day are as simple as starting and exiting the program.  
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When used in conjunction with the Remember/Lock Logon feature above, an employee’s first punch of the day is as 
simple as double clicking the TimeKron icon on the desktop. 

Other 

 

Project/Job options 
When punching in, all employees can specify a project and job from the list.  Occasionally, however, an employee may be 
working on a project or job that isn’t in the list.  If that is the case, then they may need to add a project or job on the fly.  
Here you can specify if you want employees adding projects and jobs in this manner. 

Note Options 
TimeKron gives employees the ability to add notes as easily as punching in or out.  Here, you can specify if you want 
employees to have that ability.  Additionally, you can allow the employees the ability to edit and delete employee notes. 

Time Sheet/Punch Options 
Every employee in TimeKron can punch in and out.  Additionally, every employee can view their hourly data on the Time 
Sheet page.  In order to add records to the Time Sheet, however, each employee needs to have the ‘Can use time sheets’ 
option checked.  Additionally, you can allow employees to adjust their own punches.  If that option is checked they will be 
able to adjust their punch starting and ending times in the punch grid as well as when punching in and out.  The third 
option in this section, ‘In/Out board punching without recording time’, is generally meant for those employees who want 
to use the In/Out board for tracking their In/Out Status, but don’t want to create Punch records when they punch in and 
out.  In other words, if an employee has this option checked, they can punch in and out just like anybody else and they 
will be tracked on the in/out board.  However, you will not see punch records created for that employee in the Punch 
Records grid (see Chapter 8 – Punch Records). 

Auto-Start option 
The Auto-Start option can make using TimeKron even easier.  With this box checked, TimeKron will attempt to start the 
application when Windows starts up.  It is important to note, however, that several other things need to be set up for this 
to work properly.  First, the Workstation option allowing Auto-Start needs to be checked or the Auto-Start policy will be 
ignored (see Chapter 3 – Getting Started). 

Second, the Auto-Start feature needs to be able to Log On as a specific employee.  Because of this, the employee will 
need to be set up with the Remember Logon feature from the previous section.  If this is not set up or a ‘token’ not 
established for the employee, then the Auto-Start policy will be ignored.  If those two things are in order, then TimeKron 
will start up when Windows starts up and the employee will be automatically logged on.  Starting up in this way will not 
display the main application, but will instead start TimeKron in Stand By mode.  The application will be running but it will 
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only be represented in the system tray.  The application is started up and ready to go.   You can access the features from 
the Quick Start menu (see Chapter 13 – Quick Start – System Tray) which is accessible through the system tray icon. 

Note – When the Auto-Start option is used in conjunction with Remember Logon and the Auto-Punch 
options, users can be setup to automatically Punch In when they start their computers and automatically 
Punch Out when they turn their computers off. 

Employee Policy Overrides 
Employee Policies are a good way to setup the rules of the software, but as we all know, sometimes there are exceptions.  
Instead of creating a new policy for each exception, we can make use of Employee Policy Overrides.  Employee Policy 
Overrides allows you to override specific policy settings on an employee by employee basis. 

This is done from the main Employee Information page.  Access the policy override for the employee by clicking the [?]. 

 

 

 

In this example, “-Default Exempt Policy-“ does not allow employees to add projects or jobs.  If you wanted to override 
those settings, you would click the Override Project/Job options and then check the settings that you want. 

 

This employee would be set up to add projects and jobs, even though the policy does not normally allow it.  Also note that 
when we activated the Override Project/Job options that it was the only section activated.  Each section needs to be 
activated separately.  The other sections will still be inherited from the original policy. 

If an employee has any overrides in effect, the  button on the Employee Information page will look like this: . 

Another important point is that if an employee changes policies, the overrides will still stay in effect.  For example, if an 
employee is set up with “-Default Exempt Policy-” and has overrides in effect, if that employee changes to “-Default Non-
Exempt Policy-”, those overrides will still be in effect.  It may be possible that the overridden value is the same as the 
original value, but it will still act like an override. 
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If your company uses time sheets, the time sheets will most likely have to go through some kind of approval process.  
Time Sheets that are submitted usually need to be approved by an administrator before the time is submitted to payroll.  
TimeKron handles this process through the Submission/Approval feature. 

What is the Submission/Approval process? 
The Submission/Approval process is how a time sheet goes through an examination process and how that time sheet is 
eventually given to payroll for processing.  First is the submission part.  After an employee fills out a time sheet, they need 
to submit that time sheet to an administrator for approval.  In TimeKron, submitting a time sheet is as simple as clicking a 
button that says Submit.  When a time sheet is submitted, the employee will have the option of sending an email reminder 
as well.  When an administrator sees a submitted time sheet, they have the option of approving it or not approving it.  
Either way, they can send a response e-mail back to the employee.  In a nutshell, that is the Submission/Approval 
Process. 

It should be noted that it is not necessary that you use the Submission/Approval process in TimeKron.  The system can 
work fine without it.  But for those companies that want a time sheet approval process, it is available. 

Time Sheet Status 
Time Sheets in T/SQ can have one of four statuses.  Each Status is described below. 

Not-Submitted 
The Not-Submitted status is essentially the default status for every time sheet.  Time sheets on this status will have the 
white color and will be editable.  From this status you can submit a time sheet, or jump right to approved status. 

Submitted 
The next status is Submitted.  A Submitted time sheet will have a light blue color and will not be editable.  From this 
status, you can Un-Submit the time sheet (taking it back to Not-Submitted status), or you can Approve it. 

Approved 
The next status is Approved. An Approved time sheet will have a light blue color and will also not be editable.  From this 
status, you can Un-Approve the time sheet. 

Mixed 
The next status, while rare, is called Mixed.  Simply put, a time sheet on Mixed status has more than one status for the 
selected week.  For example, if one time sheet had some Submitted time and some Un-Submitted time, then the time 
sheet would be on Mixed status. 
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Submitting 
When submitting time for a week, TimeKron will submit all time records that exist for that week.  This includes both Time 
Sheet and Punch records.  If you are only submitting Time Sheet records, you should be able to submit the time sheet 
easily.  If your time sheet submission contains punch records, the punch records need to conform to a couple of rules: 

First of all, there can be no Punch records in that period that are ‘open’ punches: 

 

An open punch is a punch that has a start time but no end time.  If you have open punches in the time period to be 
submitted, you need to either remove those records or add an end time to close those records out. 

 

Secondly, none of the punch records can have overlapping time: 

 

Those records will have to be straightened out before you are allowed to submit. 

When you click on the Submit button either on this form or the main form, TimeKron will perform these checks for you.  If 
either of these problems exist, you will not be able to submit.  If you are able to submit the Time Sheet, you will then see 
a form such as this: 

 

From here you can confirm the Totals and date range and enter in any submission notes you might want to include.  
Additionally, there is a Send E-Mail option.  If you put a check on that option, an email will be sent to all administrators 
who are set up to receive emails that have access to you, to inform them that you’ve submitted a time sheet.  Even if you 
don’t want to send an email, the Time Sheet can still be submitted.  When you are prepared, just click on the Submit 
button.  That’s it, your time sheet has been submitted.  An important thing to remember about time sheets, is that once 
you’ve submitted a time period, no new data can be added for that time period.  So make sure you have all that data 
together that you want submitted, before you do that actual submitting. 
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Un-Submitting 
If there is a change you want to make on the Time Sheet, you can use the Un-Submit button.  Only submitted Time 
Sheets can be un-submitted.  If an administrator is reviewing a time sheet and can’t approve it for a particular reason, you 
will want to use the Un-Submit process.  Once you click on Un-Submit, you will see a very similar screen as before. 

 

Once the Time Sheet has been un-submitted, you can go back to the main form to make changes. 

Approving 
In many ways, the approval process is a bit easier than the submission process.  As an administrator, you can approve 
both un-submitted and submitted time sheets.  If you are on an un-submitted time sheet, technically you can go directly 
to approved status, but the time sheet will still go through the same checks for submission before it is actually approved.  
When you are viewing a time sheet that is correct and you want to approve it, just click the Approve button.  You will then 
see a form like this: 

 

Once again you can enter in any approval notes and you can send an email to the employee that informs them that the 
time sheet was approved.  To finalize the approval, just click the Approve button. 

Un-Approving 

Occasionally, there may be a need to make a change to an Approved time sheet.  Because the Approved date range is 
locked, you can’t add or modify data directly.  The first step in the process is to Un-Approve the time sheet.  Un-Approving 
the time sheet simply takes the time sheet from Approved Status and moves it back to Submitted Status.  If you need to 
make changes, you can then use the Un-submit function. 
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Who can Submit/Un-Submit? 
Submitting and Un-Submitting timesheets can be done by virtually every employee.  Each employee needs to be able to 
use time sheets (see Chapter 11 – Employee Policies) as set up in the policy section.  If an employee is set up to use time 
sheets then they can submit and un-submit time sheets as well.  It must also be noted that administrators also have the 
ability to submit time sheets.  This means not only their own, but also timesheets of employees that they have full access 
to. 

Who can Approve/Un-Approve? 
Approving and Un-Approving of time sheets is a task that can be done by administrators only.  An administrator has 
access to approve time sheets for any employee they have access to (unless it is Read-Only access).   

Time Sheet Approval Form 

 

Submitting, Un-Submitting, Approving and Un-Approving can all be done through the main form on an employee by 
employee basis.  For submitting time sheets, this might be ideal.  However, when administrators need to approve time 
sheets moving from employee to employee on the main screen can be time consuming.  For that reason, we have the 
Time Approval Form.  This form can show time sheet information for all employees at once if necessary. 

Submitted Time Only 

 

When an administrator first opens the form, the Submitted Time Only page will be selected.  This list will show all 
employees that the administrator has access to that have submitted time sheets waiting for approval.  All employees’ 
submitted weeks will be shown.  For administrators that want quick access to only those time sheets that are submitted, 
this is where they would go.  If you want to see more than just submitted weeks, click the Options page. 
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Options 

 

On this page, you can select the week you want as in the main form.  Additionally, you can select from one of the 
departments that the administrator has access to.  On the right hand side of this page, you can also choose the type of 
weeks you want displayed.  If you only want to see employees’ ‘non-submitted’ time sheets for a particular week, then 
keep the Non-Submitted box checked and un-check the other three boxes.  The list below will show you which employees, 
weeks and statuses adhere to the criteria.  The week statuses are shown in the column at the left and the color legend as 
shown above. 

Time Sheet Info 

 

This section holds the basic information for each time sheet.  Whether you are choosing an employee from the ‘Submitted 
Time Only’ page or from the ‘Options’, you will see these fields.  If a time sheet is still on ‘not-submitted’ status, these 
fields will still be there, but the submit and approve fields will be blank. 

Time Sheet Summary 
In the lower right part of the Time Approval form is the Time Sheet Summary section.  This section breaks down time for 
each work sheet into useful totals. 

 

Here you can see how the week breaks down between Regular and Overtime hours.  If you are interested in Project 
and/or Job Totals, just select it from the drop down list box. 
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This section can break the time down by projects and jobs.  Here, you can see the breakdown for each project and job 
combination.  You can also break it down by just projects or just jobs by selecting a different option from the drop down 
list box. 

Time Sheet Details 

If the summary section isn’t sufficient to approve time, the  button can show the entire time sheet. 

 

Keep in mind that any time sheet viewed through the Details function cannot be edited, even the time sheets that are on 
Not-Submitted status. 

Email Notification 
Email Notification was discussed previously with regard to submitting and approving time sheets.  This option is not 
necessary, but can be a handy tool to use so that administrators know when time sheets need to be approved and 
employees know if their time sheets have been approved.  To use Email Notification, you need to have two things.  First, 
you need to make sure that Email Configuration is set up properly (see Chapter 3 – Getting Started).  Second, you need 
valid email addresses for employees and administrators alike.  If an employee or administrator doesn’t have an email 
address set up in Employee Information (see Chapter 4 – Employee Information), then they can’t receive emails. 

As far as administrators are concerned, if an administrator wants to receive email notifications from employees, then the 
security needs to be setup properly.  Full access (green check mark) does not receive email notifications from employees.  
You will need Full w/email (blue check mark) to receive email notification. 

Employees receive email notification responses from administrators regardless of their security settings. 
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Whenever you start up TimeKron (except for Punch Station mode), the Quick Start menu icon will appear in the System 
tray in the lower right part of your screen. 

  

The TimeKron Quick Start icon is circled above.  From the Quick Start Menu, you can quickly access the important features 
of TimeKron. 

 

Current User/Status 

 

The Quick Start menu always displays the currently logged on user.  This is the user who entered in their user name and 
password when the application started up.  Here the current user is Thomas Smith. 

Additionally, you can see the current In/Out status as well as the last punch time of Thomas Smith.  In this case, Thomas 
Smith was punched out at 11:34 AM.  You can also see the details of the last punch including the project and job. 

Punching In/Out 

 

From these three buttons, the current user can punch in and out simply from the System tray.  The punching process is 
identical to the one discussed is Chapter 6 – Punching In and Out.  If Quick Punching is more your style, you can check 
the Quick Punch checkbox and clicking the Punch buttons will quick punch you in or out.  In this case punching is as 
simple as a single click. 
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For those employees who want a quick punching process, this is your answer.  The system tray is always available and all 
the employee has to do is to click on the TimeKron icon in the system tray and then punch in or out.  Two clicks and you 
are punched in or out. 

Make Note 

 

The Quick Start menu also allows quick access to add notes into TimeKron.  These notes are unlimited and free form so 
you can add as many as you like.  Just click the TimeKron icon in the system tray and then click Make Note and you are 
there.  For more information on Notes, refer to Chapter 9 – Notes. 

In/Out Board 

 

Another handy tool you can access from the Quick Start menu is the In/Out board.  From this menu you can toggle the 
In/Out board on and off.  For more information on the In/Out board, refer to Chapter 5 – In/Out Board. 

TimeKron 

 

This button will activate the main application. 

Exit 

 
Quite simply, the Exit button will exit you out of the application.  When you exit a screen will appear requesting you to  
confirm that you want to exit. 

 

Stand By 
‘Stand By’ is a concept that is only partially associated with the Quick Start menu.  When you try to exit from the Quick 
Start menu, you will get the exit screen as above.  When you try to exit the application by clicking the ‘X’ in the upper right 
corner or by clicking on File>Exit, then you will see a different exit screen. 
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On this form, clicking the Exit/Log Off button will do just that, exit the application completely including the Quick Start 
menu.  Clicking on the ‘Stand By’ button will do something different.  Clicking on the ‘Stand By’ button will hide the main 
application, but the Quick Start menu will still be active in the system tray.  This will give you access to some key features 
in TimeKron.  If you want to go back into the main application, you can still do that through the Quick Start menu. 

 Remember Logon 
Another feature when exiting is the Remember Logon feature: 

 

TimeKron has the option of remembering Log On information for users.  For more details, see Chapter 11 – Employee 
Policies.  For those users that are set to have their Log On information remembered, the exit screen will look like this.  If 
you want TimeKron to remember your Log On info, then leave the checkbox checked and exit the application.  The next 
time you come in to TimeKron, it should bypass the log on screen.  Users who have their Log On info ‘locked’, will also see 
this screen.  It behaves in exactly the same way, except for the Remember Log-On checkbox.  If a locked user tries to 
uncheck the box, TimeKron will prompt you for a user name and password.  To properly unlock a locked user, a Super 
Administrator needs to authorize it.  
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Some office environments will allow individuals to access TimeKron from their own workstation where they can punch out 
at their leisure.  This is usually done by use the Punch feature through the Quick Start menu.  Other offices, however, may 
still need to have employees punch in and out, but won’t have workstations for all of them.  For that situation, we have 
the Punch Station.  The Punch Station is different from other TimeKron features.  To access Punch Station, click 
Start>Programs>TimeKron>Punch Station.  The first time in, you may see a screen that looks like this: 

 

The Punch Station can be accessed by anybody, but a Super Administrator must first set it up.  If a Super Administrator 
does not set up the Punch Station, it will always be blank as you see here.  To set up the Punch Station, a Super 
Administrator clicks on the Setup button.  It will prompt for a username and password.  After the Super Administrator 
enters the info, the following screen will apear: 

 

All of these options have an effect on how the Punch Station works, but the most important option is the Station Enabled 
option.  If this option is unchecked, then nothing on the Punch Station will be enabled.  Additionally, if this option is 
unchecked, you will be unable to change any of the other options.  Once the Station Enabled option is checked, you can 
use the other options. 
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The Employee selection option works much in the same way as the In/Out Board (see Chapter 5 – In/Out Board).  One or 
more employees or departments may be selected for viewing.  Also keep in mind, you can create multiple punch stations 
on your system.  One Punch Station may keep track of the Administration department, and another may track the Sales 
department. 

The Name option will determine how the name is displayed in the Punch Station. 

The Authentication Required option determines if authentication is required for each punch on the punch station.  If this is 
checked, anytime someone punches on the punch station, they will be prompted to supply a user name and password. 

Allow Admin Punches is similar to the above option in that it will allow Administrators to use their user name and password 
to punch other employees in and out. 

Finally, the Refresh Rate determines how often the Punch station will automatically refresh. 

After you’ve selected your options, click OK to go back to the main Punch Station form.  If you’ve checked Station 
Enabled, it might look something like this: 

 

As in the In/Out board, this form also has the current time and a refresh button for a manual Refresh of the Punch 
Station. 

You can punch in and out by clicking in the In and Out columns for the specified employees. 
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TimeKron’s main job is to track time worked.  It does this through tracking both punches and time sheet time.  The main 
source of TimeKron’s punches is TimeKron itself.  However, TimeKron does allow punches to be processed from outside of 
the TimeKron application.  The External Punch System first must be enabled through the Super Administrator options 
before it can be used.  See Chapter 3 – Getting Started. 

Open Architecture Punching 
Open Architecture Punching (or OAP for short) is the technology that TimeKron uses to integrate external punches into the 
application.  In essence, OAP can provide the ability for TimeKron to accept punches from virtually anywhere.  Through an 
ODBC connection, other applications can enter raw punch data into a staging table in the TimeKron database.  TimeKron 
then detects and processes those staged punches.  They are applied using all the policies and rules setup by the TimeKron 
administrator.  The possibilities for using OAP are endless. 

How to use it 
Every TimeKron application sets up a database.  One table that it sets up in that database is called External_Punch.  This 
is the staging table which drives the OAP process.  The relevant fields in this table are as follows:  Badge ID, Punch Time, 
In/Out Status, Project Code, Job Code, Punch Location, and UTC Offset.  To enter an external punch, you just need to 
insert a record into the External_Punch table.  The minimum required fields are the Badge ID, Punch Time and In/Out 
status.  The rest of the fields are voluntary.  UTC Offset represents a time zone offset.  If TimeKron is processing punches 
from two different time zones, it will use this field to normalize the times. 

Hardware 
Hardware such as punch clocks can also take advantage of OAP.  Many hardware devices track things such as Punch 
times and In/Out status as well as a Badge ID that was used to punch with.  With this basic information, you can transfer 
punch information from most punch clock hardware to TimeKron. 

Device Manager 
Software Techniques offers punch clock hardware for use with TimeKron.  The entire package, which includes software 
and hardware, is called TimeKron Complete.  The Device Manager software takes punches from multiple devices and 
transfers those punches to TimeKron.  The supported devices include a Serial Port, Ethernet, and Modem time clock 
devices.  For more information and pricing on the Device Manager and TimeKron Complete, contact Software Techniques 
at 540-721-1000. 

OEM Integration 
Through the use of OAP, other equipment manufacturers (OEM’s) can integrate their punch clocks with TimeKron.  
Contact your OEM’s for more information or contact Software Techniques for a list of recommended OEM’s. 
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Web Based Punching 
Another innovative way to use OAP technology is through the internet.  Punching in to TimeKron could only be a few 
mouse clicks away.  Web sites can be created to accept punch information and then send the results to TimeKron.  One 
way to accomplish this is through the use of an ASP script.  Appendix A  provides a sample ASP script which can be used 
by your own web administrator to integrate OAP into your company’s own web page. 

External Punch Error Maintenance 
While using OAP technology and the External Punch System is very useful and flexible, there are times when punches 
entered externally cannot be processed.  The primary reason for a processing error would be an invalid Badge ID.  In this 
cases, we need to use the External Punch Error Maintenance form.  To access this form, click on Tools -> External 
Punch Maintenance. 

 

This form shows every punch in the External_Punch database that has not been processed.  The relevant data for each 
punch is displayed in the listbox.  The key data for each punch is the Badge ID, Punch Time and In/Out. 

When dealing with punch errors in this form there are several things you can do. 

Remove and Remove (Batch) 
If you see a punch in this screen that does not belong, you can simply remove the punch.  If you want to remove a single 
punch, just click the punch record and then click the Remove button.  You will be given a brief confirmation screen before 
the punch is officially removed.  The Remove (Batch) button can remove all punches for a specified Badge ID.  If you 
want to remove all punches of a particular Badge ID, just click a single record with the Badge ID that you want to remove 
and click the Remove (Batch) button.  The confirmation screen will be similar, but it will refer to removing all punches with 
the same Badge ID. 

 

Change ID and Change ID (Batch) 
Another approach to correcting punch errors is to change the Badge ID of a punch.  It is possible and likely that some 
employees’ Badge Ids will change over time.  If the Badge ID change does not get updated in TimeKron, then it will not 
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be able to associate a Badge ID with the correct employee.  To change the Badge ID of a punch, click the punch you want 
to change and click the Change Badge ID button. 

 

On this screen, you can see each employee in the system and their Badge ID.  Just select the employee and Badge ID 
that you want to change the punch to and click OK. 

You will then be given a final confirmation screen about the Badge ID change. 

 

To complete the Badge ID change, click OK. 

The Change Badge ID (Batch) button works in a similar fashion.  You still select a single record of the Badge ID you want 
to change.  After clicking the Change Badge ID (Batch) button, the same Badge ID selection form will come up.  The 
confirmation screen will look a little different. 

 

To change all the Badge Ids, just click the OK button.  Following the changing of a Badge ID (either single or batch), the 
entire list will be reprocessed.  In theory, the punches you’ve just changed should actually process now and they should 
be removed from the list. 

Reprocess List 
Corrections to the Badge ID can also be made in the main application.  If you have already made the necessary 
adjustment to the Employee Information you will need to reprocess the list of errors.  To do this, click the Reprocess List 
button.  This will attempt to reprocess all of the external punches. Any external punches that have been successfully 
processed will no longer appear on the list.  Any external punches that still appear on the error list were unable to be 
reprocessed. 
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Warning Icon 
If you are using the External Punch System and OAP, you will probably want a way of knowing if there is a problem with 
your external punches.  TimeKron provides this with a warning icon.  If external punch errors exist, you will see an icon 
like this on the main screen. 

 

This will appear in the lower left part of the screen.  For quick access to those errors, just click the icon itself and the 
Punch Error Maintenance form will come up. 
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TimeKron has well over 20 different report forms and a number of the reports have different variations of that report.  
There are many features that are common among report screens. 

Common Features 
 

 

This information will be seen in every report. 

Report Title 
This is the name that will appear in each report header as the report title.  Each report comes with a set name, but you 
can change it you wish.  Below the Report Title is the report description giving a brief description of the report. 

Administrator Title Lock 
When a Report Title is changed, it is changed for the entire system.  If an administrator wants to lock down report titles to 
keep people from changing them, they can click on this button.  Then only administrators can change that report’s title.  
This setting can be different for each report. 

Low Resolution Printer 
Occasionally, some TimeKron reports have graphics to display.  Some printers may have trouble printing some graphics.  
If you want to print a report without a lot of graphics, just check this option and it will be mostly lines and text.  This 
setting is for the workstation only. 

Company Logo in Header 
In the Super Administrator Options form, each system can specify a Company logo to appear in reports.  If you have a 
company logo specified, this checkbox will be enabled and you can check it off if you want to see the logo in the report. 

Company Name in Title 
Also in the Super Administrator Options form, each system can also specify a company name to appear in reports.  If you 
want to see the company name in the header of the report, just check this option. 
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Print button 
This button will print the current report. 

Preview 
This button will allow you to Preview the report before printing, emailing or creating an HTML document. 
In the Preview mode, a Report Preview Toolbar will appear on the screen  

 

The Report Preview Toolbar allows you to select any portion of the report you want to view.  With the 
Report Preview Toolbar you can: 

• Move to the first or last page of the report 

• Move to the previous or next page of the report 

• Move to a specific page in the report 

• View one, two or four pages at a time 

• Zoom in or out of the report 

• Print the report 

• Close the Preview window 

E-mail 
This button will allow you to e-mail the report to an employee or manager.  After clicking on the E-mail 
button the follow screen will appear: 

 

The report’s title is in the upper left part of the form.  If you want to see the e-mail that will be sent, you 
can click the Preview button.  In the lower left part of the form, you can enter the e-mail subject and any 
additional text you want to include.   
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The list on the right is a list of employees and their e-mail addresses, if they have one.  To add an 
employee to the recipient list, double click the employee or click the recipient and click the Add button.  If 
you want to include a recipient that is not in the list, click the “Add Other Recipient”, which is located 
above the Recipient List.  A window will appear. Enter the e-mail address of the recipient and click OK. If 
you want to send an email to all employees within a department, click Departments, and select the 
department(s). Only employees with e-mail addresses will receive the report. 

Once you have selected one or more recipients, the Send E-Mail button will become enabled.  When you 
have selected all the recipients, click this button and it will start sending the E-mails.  The Send Log 
section in the lower right will display the sending progress. 

HTML 
This button will allow you to create and save an HTML document.  When the Save Window appears, give 
the HTML document a name and click Save. 

Common Report Criteria 
Throughout all of the reports, there will be a number of different controls used to determine the criteria for the report. 

Employee/Department Selector 

 

This one allows you to select one or more employees or one or more departments for the report selection.  Additionally, 
you can remove terminated employees from the selection by un-checking the checkbox on the bottom. 

Department Selector 

 

This one is very similar, but it only allows departments to be selected, no employees. 
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Project/Job Selector 

 

Most of the reports allow you to pare down by project and job.  Here you can specify which projects and/or jobs you want 
to report on. 

Date Range 

 

Most of the reports also have date constraints.  Here you can specify a from and to date for the report. 

Submission Types 

 

In TimeKron, time can have three different statuses:  Approved, Submitted and Un-submitted.  Here you can specify the 
kinds of time-status you want to report. 

Time Format 

 

With this option, you can specify how you want the time displayed in each report.  If this is checked, time totals will be 
displayed in hours and minutes (e.g. 10:15).  If it isn’t checked, time totals will be displayed in hundredths of an hour (e.g. 
10.25). 

Sorting options 

 

Some reports have a sorting option as well.  Here you can specify one of many ways to sort the report’s data. 
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Week Selector 

 

Some of the reports, also have a week selector as shown here.  Here you can select one or more weeks to report on.  The 
weeks you’ve already selected are shown on the right. 
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Department Reports 

 

Department Profile 
This report shows each department and the employees in that department. 

 

 



Chapter 16 – Reports 101 

Department Details 
This report shows the hours worked by each department. 
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In/Out Board 
This report shows the current in/out status of a group of employees. 
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In/Out History 
This report shows a history of in/out punches for the specified date range. 
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Notes 
This report allows you to report on notes from your employees for a specified time period. 
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Overtime Check 
This report shows employees who have exceeded daily or weekly overtime amounts.  You can specify whether you want 
to compare on daily or weekly overtime. 

 

 

 



TimeKron User Manual 106 

Payroll Summary 
This report breaks down regular and overtime hours worked and displays the compensation for each employee. 
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Policy Report 
This report displays the basic information for each policy selected. 
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Security Report 
This report will show the different security level settings for the selected employees. 
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Department Summary by Job 
This report summarizes department information by job. 
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Department Summary by Project 
This report summarizes department information by Project. 
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Punch Errors 
This report will show open and overlap punches for a specified date range. 
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Employee Reports 

 

Employee Details 
This report shows detailed employee time information for a group of employees. 
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Employee Profile 
This report shows basic employee information 
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Excessive Hours 
This report can show you which employees have time segments exceeding a particular amount. 
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Lateness Check 
This report allows you to show employees who clocked in past a specified time. 

 

 

If you are using SoftTime in conjunction with TimeKron, you will see the option as it is above.  If you choose the ‘Use 
employee first shift segment from SoftTime’, the cutoff time checked will be the start of the first segment as it appears in 
SoftTime.  Otherwise, you can specify a specific time which will be checked against all employees.  Also, you can include 
employees that were on time for the specified date range. 

 



TimeKron User Manual 116 

Employee Summary by Job 
This report summarizes employees’ time and breaks it down by job. 
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Employee Summary by Project 
This report summarizes employees’ time and breaks it down by project. 
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Time Sheet 
This report will print time sheets for employees for the specified weeks. 
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Time Sheet Status 
This report can quickly assess the status of your employees’ time sheets for one or more weeks. 
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Project/Job Reports 

 

Job/Project Profile 
This report shows each job and their associated projects. 
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Project/Job Profile 
This report shows each project and their associated jobs. 
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Project Recap 
This report summarizes every project. 
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Project Details 
This report provides details about each selected project for a specified date range. 
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Project Time Summary 
Similar to Project Details, this report will summarize project time for a specified time period. 
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Job Details 
This report shows details for each job for a specified time period. 
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Job Summary 
This report summarizes time for each job for the specified date range. 
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Importing 
TimeKron supports importing data from a variety of other software programs and other versions of TimeKron. There are 
two options in TimeKron for importing data into your SQL database. One option is to use the DBADMIN mode to do a 
Total Import (see Total Import Instructions in Chapter 2). 

Under the file menu there is another utility for importing data into your TimeKron database. Before using this utility you 
will need to setup your data as you want it. This utility is primarily used to add employees and departments to your 
TimeKron database that you have already setup. This can even be used to add employees to a TimeKron database that 
you are using. To use this utility you must be operating in Super Administrator mode. 

To begin importing data, select File->Import from the menu. TimeKron features an Import Wizard to lead you through 
the steps of importing your data. 

 

Generic Data File 
With a generic data file, you can choose to import either employees or departments. 

 

Next you must choose the Generic Data File to Import. It is helpful to use the first row of your import file as headers. 
These will display in the next step when you have to map the column names. Generic Data File types can be xls, txt, csv, 
dbf, etc. 
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With generic data file imports, you will need to match the TimeKron Fields to the fields in the import file.  TimeKron will try 
to match the fields as best it can. All of the fields do not have to be matched, but to move to the next step, you must 
match up the name field. You can match up fields by selecting a field and using the << and >> buttons or by dragging 
and dropping between the lists. 

 

Duplicate Handling tells TimeKron how you wish it to handle duplicate records that it comes across. Your choices are to 
skip or to allow duplicate records. Skipping will not import a record identified as a duplicate. Allowing duplicates will import 
the record and you can review both records in TimeKron to determine which is valid. 
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Press the Next button to move to the last page. 

 

From here, you just need to click on the Finish button and the Import will begin.  Depending on the number of employees 
you have, the import process may take several minutes. 

Importing from TimeKron 
Importing from TimeKron is very similar, but there is one less step.  From the first screen, select TimeKron and you will 
see the following screen. 

 

Enter the location where the TimeKron executable file exists in the field.  From there, TimeKron can figure out where your 
data exists. 

After you click next, you will see the Duplice Handling page as shown above.  Then you will just need to click Next one 
more time to get to the final page and click Finish.  The TimeKron import should then begin. 
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Exporting 

 

TimeKron’s Export form doesn’t look all that impressive, but in this case, looks can be deceiving.  TimeKron now has 
export templates for exporting time data to your favorite payroll programs.  Even better is that the templates are 
customizable by the user! 

Export Templates 
Export templates in TimeKron come in two types:  Built-In and Custom.  Built-in templates are hardcoded into the system 
and cannot be deleted or edited.  Currently there are 4 Built in templates.  Custom templates are templates that have 
been created by the user and can be adjusted or deleted at will.  Built-in and custom templates both work in the same 
way, but the built-in templates are created for exporting to specific applications.  The difference between Built-In and 
Custom templates can be seen in the template selection screen. 

 

 

and in the main form once a template has been selected. 

 

Exporting Basics 
Exporting data from TimeKron is actually quite simple.  First, you need to select an export template as shown above.  
Then you want to select the group of employees that you want to export data for.  Next, you need to specify a date range 
for the export.  The above illustration shows a date range to enter.  Some templates require specific weeks to be selected 
and in those cases, the date range controls will be replaced by the week selector.   
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Next, you need to decide what type of records you want to export.  You can choose between Not Submitted, Submitted 
and Approved statuses.  You can choose one, two or all three of them.  Next, you need to click the Export button.  After 
you click on the export button, you will be prompted as to where you want the export file to be placed as well as a name 
for the file.  Once you have specified that information, the export will begin.  That’s it. 

Creating/Editing Custom Templates 
As stated before, TimeKron allows users to create custom export templates.  If you use a payroll system that is not 
supported by one of the built-in templates, you can create your own export template to do the job for you.  Creating and 
editing templates are very similar.  To create a template, just click the New button on the main export form.  To edit a 
custom template, click the Select button and select the template you wish to edit from the list.  Once you see it on the 
main export form, click the Edit button.  Whether you are editing or creating, each of the following sections pertains to 
setting up the export template. 

Output File Type 

 

This setting determines the format of the resulting export file.  The choices are shown above.  The type you choose 
depends on how you want to view the data and how your payroll program receives data.  After picking the Output File 
type, click the Next button on the bottom. 

Data Grouping 

 
 

Once you’ve selected an Output File Type, you need to choose the data grouping for the export file.  This is a crucial step 
in creating your export template.  Here is an explanation of each type of data grouping. 

Employee – Export data will be grouped by employee only.  This usually has the effect of coming up with grand totals for 
a date range. 

Employee, Day – Export data will be grouped by employee and day.  This means that if an employee has several punches 
or time segments for one day, they will be consolidated into one day.  The result will be one record in the export file for 
each day of data for each employee that is exported. 
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Employee, Day, Pay-Level – Export data will be grouped by employee, day and then pay level.  In this case, pay level is 
separated between regular time and overtime levels.  TimeKron will break down time for each day and group the time into 
the appropriate pay level for each day.  For example, an employee could have regular time and overtime hours on the 
same day.  This method accounts for that. 

Employee, Pay-Level – Export Data will be grouped by employee and then pay level.  This method will not group by day, 
but for a week range.  For the specified range, the export file will provide the total amount of time for each pay level.  For 
example, for each employee in the export, there will be one record for each relevant pay level.  This will include at least 
regular hours and could include as many as four additional overtime levels. 

Employee, Punch Clock Records – Export data will be grouped by employee and then by punch clock record.  This one is 
similar to Employee, Day, except that all the records for a day will not be totaled.  In this method, each individual punch 
record that exists for the employee for the date range will be provided in the export. 

Employee, Week – Export data will be grouped by employee and week.  This export will total all time for each selected 
week for each employee. 

Employee, Week, Pay-Level – Export data will be grouped by employee, week and then pay level.  Similar to the previous 
method, but the total time will be broken down by pay level.  For each week selected there will be one or more pay level 
records for each employee. 

As stated above, choosing the right data grouping is crucial to creating the correct export template.  If you are looking for 
a specific kind of data grouping that you don’t see here, contact Software Techniques for further assistance.  Once you’ve 
selected the Data Grouping, click Next. 

Date Range Type 

 

Once you’ve selected a data grouping, you will need to specify a date range type for the export.  The options here are 
reduced to two.  Date range is simply where the user specifies a starting and ending date for the export.  Week range is 
where the user selects one or more weeks for the export.  Take note that depending on what data grouping you choose, 
your date range type options may be limited to just one.  For example, Employee – Pay Level only allows Week Range.  In 
that case, date range will be disabled in the listbox.  After choosing the Date range Type, click Next. 

Export Column Header 

 

If you choose .CSV or .TXT type, you will see an option for Export Column Header.  If you check this option, then each 
column in the export will have a column header at the top of the file.  If it remains unchecked, then every single row will 
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be exported.  If you choose a type other than .CSV or .TXT, you will still see the checkbox, but it will be disabled and you 
won’t be able to use it.  Click Next when done. 

Choose Export Fields 
After the Column Header option, it’s time to get in to another key step in creating your export template, choosing export 
fields.  After the previous step, you will see the following appear to the right in the form: 

 

It’s not much to look at right now, but when you finish, it will have very pertinent information in it.  Let’s take a look at 
adding a field.  To add an export field, click on the Add… button.  It should bring up a form that looks like this: 

 

The field categories are listed at the top.  The fields themselves are on the left and a description of each field appears to 
the right as you select a field. 

The Employee Fields category has employee related personal information.  Any of these fields can be added to the export 
template. 

 

The Time Fields category has the key fields for the export.  Here you can choose which time related fields you want to 
include in the export template.  You will notice that some fields are disabled.  Each data grouping uses different types of 
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Time Fields.  If you see a Time Field that you want to use, but it is disabled, you may have to change the Data Grouping 
to get access to that field. 

Whether it is an Employee or Time Field, simply select the field from the left and click Select on the bottom. 

After you’ve chosen several fields, you might get a screen that looks like this: 

 

The order that you see them in here is how they will appear in the export file.  However, if you want to change the order 
that you see here, you can use the ‘mover’ bars to the left of the field name.  Just left click and hold down the button over 
the small box to the left.  Then just drag the field to the position you want.  That’s it!  You can do this with every field. 

Once you’ve selected all the fields you need, click the Next button on the bottom. 

Save Template 
You will see this appear in the lower right portion of the screen. 

 

Now you can Save the template.  If you are creating a new template, then the Save As button will be enabled as you see 
here.  If you are editing a template, the Save button will be enabled as well.  Once you save the template, click the Finish 
button to return to the main Export form.  The template you were just working on should be selected. 

 

Built-In Templates 
TimeKron comes with a few built-in export templates for some of the more popular payroll programs.  Following are some 
specific instructions for the built-in templates. 

Peachtree Accounting Plus 
Prior to performing the export in TimeKron, you need to make sure that the data in both Peachtree and TimeKron will 
properly correspond. You need to check the following things: 

1. Each employee in TimeKron must be created in Peachtree. 

2. Each employee ID number in TimeKron must match the one in Peachtree. 

3. Each TimeKron department name must be created in Peachtree. 

4. You must know the ID numbers for the regular time, overtime and Activity ID numbers 

(all of which can be found in Peachtree during the initial setup of the program.) 
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Once you have confirmed that the data corresponds, you are ready to start the export. Perform the export as described in 
Exporting Basics above.  During the export process for Peachtree, you will be prompted for a Regular Hours Activity ID 
and an Overtime Hours Activity ID.  These values should be found in Peachtree. 

After you’ve completed the export, you will then need to import that file into Peachtree.  These instructions should help 
you out: 

 

1. From the File menu, click Select Import/Export 

2. On the left side of the screen, select the Time/Expense option. On the right side of the 

screen, select the Time Ticket Register option. 

3. Next, select the Import button from the top of the selection screen. 

4. On the layout tab, uncheck the following fields on the import screen: 

(a) Invoice Number Used 

(b) Start Time 

(c) End Time 

(d) Break Time 

(e) Memo 

(f) Unit Duration 

5. Click on the Options tab 

6. In the Import/Export File section, click on the arrow button. You can now choose the file you 

just created in TimeKron. 

7. Click OK and the import process will begin. 

8. Once the import is complete, Peachtree will take you back to the Import/Export File screen. 

Quickbooks Pro 
Prior to performing the export in TimeKron, You need to make sure that the data in both QuickBooks and TimeKron will 
properly correspond. You need to check the following things: 

1. The employee’s whole name in TimeKron must match the name as entered into QuickBooks. 

2. You must have Salary, Overtime and any other payment activity types created in the Payroll section in 
QuickBooks. 

3. The item Customer:Job refers to the department name. 

Another thing you will need to do before you can use the TimeKron export is to find Quickbooks’ Company Create Time.  
To find the Company Create Time, follow these instructions: 

1. In QuickBooks Pro, make sure your company file is open. 

2. Click on File. 

3. Click on Timer, Export Lists for Timer. 

4. You will then be asked to supply the name of the file you are about to export. Make sure you 

will be able to find it easily. 

5. After typing in the name, click OK. 
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6. You should then see a prompt that says ‘Your data has been exported successfully’. 

7. To find the Company Create Time, from your Windows desktop, Click on Start, Programs, 

Accessories and select Notepad. 

8. In Notepad, click on File, then Open. 

9. Find the file you just exported from QuickBooks. 

10. When the file is open, search for the line that starts with TIMERHDR (could be the 2nd or 3rd 

line down.) 

11. Write down the 9-digit number that is at the end of that line. This is your Company Create Time. 

 

Once you have confirmed that all the data corresponds, you are ready to begin the export.  Perform the export as 
described in Exporting Basics above.  During the export process for Quickbooks, you will be prompted for the Company 
Create Time and Company Name.  Once you’ve entered them in, TimeKron will remember these values for you. 

After you’ve completed the export, you will then need to import that file into QuickBooks.  These instructions should help 
you out: 

1. In QuickBooks, make sure your company file is open. 

2. Click on File. 

3. Click on Timer, Import Activities from Timer. 

4. You will then be prompted to enter in the name of the file you just exported form TimeKron. 

5. Click OK to start the Import. 

6. After importing, you can either choose View Report to see what was just imported or Close to close the 
prompt. 

ADP 
Prior to performing the export in TimeKron, you need to make sure that the data in both ADP and TimeKron will properly 
correspond. You need to check the following things: 

1. Each employee in TimeKron must be created in ADP. 

2. Each employee ID number in TimeKron must match the one in ADP. 

3. Each TimeKron department name must be created in ADP. 

Once you have confirmed that all the data corresponds, you are ready to begin the export.  Perform the export as 
described in Exporting Basics above.  During the export process for ADP, you will be prompted for the Company Code.  
ADP should have provided this code.  Once you’ve entered it in, TimeKron will remember it for you. 

When naming your ADP export file, ADP has a specific naming convention that they use.  It is PRcccEPI.csv, where ccc is 
the company code you entered in earlier. 

If it isn’t there already, move the export file to the C:\adp\pcpw\adpdata subdirectory (where c is the drive where ADP is 
installed). Import the data into ADP by checking PC/Payrolls online help, paydata entries, importing for more information. 

Checkmark Payroll 
Prior to performing the export in TimeKron, you need to make sure that the data in both CheckMark and TimeKron 
properly correspond. You need to check the following: 

-The first and last name in TimeKron must match the first and last name that is in CheckMark. 
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Once you have confirmed that all the data corresponds, you are ready to begin the export.  Perform the export as 
described in Exporting Basics above. 

To import the file into Checkmark: 

1. In CheckMark, choose Enter Hours from the payroll menu. 

2. Click the Import Hours button. 

3. Select the text file you just created in TimeKron and click OK. 

4. If you attempt to import the hours of an employee that do not exist in CheckMark, you will be notified and 
prompted to continue the import or cancel it. 

5. After the hours have been imported, click Save. 
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Help Menu 

 

License Agreement 
The License Agreement can be seen at the beginning of this User’s Manual. 

Upgrade License 
This utility allows you to upgrade your number of user licenses for TimeKron.  This screen will have your current activation 
code and your current number of licenses.  You can call Software Techniques or your TimeKron reseller and purchase the 
additional codes, and you will be given a new activation code to upgrade to the newly purchased number of user licenses. 

 

Once you enter the new activation code and press the OK button, TimeKron will exit.  The next time you enter the 
program, the new number of user licenses will be activated. 

Web Update and Automatic Upgrades 
This feature allows you to automatically check www.softwaretech.com for recent upgrades and patches.  If you would like 
to set the interval for performing these checks, you can run the Web Update option from the Help menu. 
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If a new version is available via the web an Icon will appear in the bottom left corner of the main screen: 

 

To download the web update, click on the web update icon .  This will do two things.  First it will download the update 
files to the auto-upgrade directory (hopefully) on your network.  You will need to have read/write and file creation access 
to this directory to successfully download updates.  Once the files are downloaded they will automatically be installed on 
your workstation.  You will then probably need to restart TimeKron.  Most upgrades will not require you to reboot. 
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Each time you attempt to login to TimeKron, the software will automatically check the auto-upgrade directory to see if 
your workstation is running the most recently downloaded version of the software.  If you need to upgrade your 
workstation you will see a screen that will require you to update. 

 

As you upgrade your old TimeKron executable will be backed up and a progress bar will be displayed.  After completing 
the upgrade you will have to restart TimeKron. 

 

Sometimes an upgrade will require that the SQL Database is also upgraded.  TimeKron constantly checks the SQL 
database to make sure it is compatible with the software.  If the database and the application become out of sync, you 
should have your DBA run TimeKron in DB Administration mode. 

Software Techniques on the WEB 
This option launches your default Web browser to Software Techniques, Inc. main Internet site.  The web URL is 
http://www.softwaretech.com. 

 

 

STI Website 

http://www.softwaretech.com/
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Technical Support Options 
This screen shows information about how to get help with your TimeKron product. 

 

About TimeKron 
The About TimeKron screen gives information about your installed version of TimeKron.  It is useful if you ever need to 
make a support call to give your version, serial number, etc. 
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DB Administration Mode 
Database Admin mode is demonstrated in Chapter 2 – Installation and Setup.  If you are using the SQL version, find the 
section entitled Database Connection and Setup – SQL version on how to use DB Admin mode.  If you are using the 
Diamond version, find the section entitled Database Connection and Setup – Diamond version. 
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Technical Support 
If the information you need to solve a problem is not in the manual, please do the following: 

1. Review the list of Common Problems and Solutions that follow, to see if your problem is there 

2. You can also receive on-line support via our Technical Support Web Page on the Internet at  
http://www.softwaretech.com.  Product support is free for the first 15 days that you own TimeKron.  
Beyond that time, support and E-mail calls are billable. 

3. Refer to the Microsoft Windows User Manual for help with problems caused by the operating environment 
or the Windows Graphic User Interface. 

If steps 1-3 were not able to help, you may call Software Techniques Inc. at (540) 721-1002 for technical support.  Our 
staff is on duty Monday through Friday, from 9:00 AM - 12:00 PM and 1:00 PM - 5:00 PM, Eastern Time.  You may also 
FAX your questions to us at (540) 721-1010.  Before you call, though, complete the following steps: 

1. Be sure you are eligible.  Product support is free for the first 15 days that you own 
TimeKron.  Beyond that time, support and E-mail calls are billable. 

2. Have the TimeKron serial and version numbers handy.  You can find them on the installation 
CDs, and copy them here:  

Activation Code _____________________ Version # ________ 

3. Note the amount of available disk space on your drive, _____________ and the amount 
of RAM on your computer _________________.  Also, note the available disk space within 
your common directory ____________. 

4. Verify your ODBC connection is working properly.  Write down the name of the SQL Database 
you are connecting to.  [____________________]  (It should appear on the main screen in 
[brackets]). 

5. A problem may be database related so have your SQL DBA near by in case he/she needs to 
be consulted.  Also make sure you have full read/write/create privileges to your common 
directory. 

6. If an error has occurred, write down the first error message exactly as it appears on your 
screen.  Write down the steps you took just before the error message appeared.  

7. Be prepared to provide our Technical Support staff with any information they need.  
TimeKron generates a log file that may help us diagnose complex problem.  We may ask you 
to send this file to us for analysis. 

http://www.softwaretech.com/
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Common Problems and Solutions 

 My Password doesn’t work. 

  The first time you log in, the system defaults to a User Name of “Admin”.  No 
Password is required.  Just press Enter and you will be logged in to the software. At 
this point, you can set up individual User Names and Passwords by clicking on the 
Employee Information tab. 
Remember, the password field is case sensitive. Check your caps lock key. 
You can also adjust your workstation options for each individual 
workstation. 

 Error Message - Cannot locate FoxPro Support Library. 

 The computer does not have the FoxPro DLL files installed.  These can be 
obtained by reinstalling the software.  Make sure the data files are backed 
up before reinstalling. 

 Computer freezes when trying to load TimeKron. 

 You workstation probably does not meet the minimum requirements.  Make 
sure that no other programs are running in the background.  If the problem 
still occurs, change the display on the video driver to a standard Super VGA 
display. 

 I receive the following error message: 
 “Unable to login to TimeKron.  Common directory does not exist.” 

 You are unable to connect to the common directory.  If it is on a network, 
make sure you are properly connected and logged in to that network.  
Check your network cable.  If the problem continues contact your network 
administrator. 

 I receive the following error message: 
 “Unable to login to TimeKron.  Invalid ODBC Connection.” 

 You are unable to connect to the SQL Database.  This may be because your 
SQL Server is down or because your SQL account does not let you connect 
to the database.  If the problem continues contact your SQL DBA. 

 I receive the following error message when trying to login: 
 “SQL Command w/ error [UPDATE ...]”. 

 The SQL DBA has restricted your use of the database (permissions) such 
that you cannot properly access the database in the required fashion.  It 
has been altered into an unusable format.  Have your SQL DBA run 
TimeKron in DB Admin mode and use the configuration tools to repair the 
problems. 
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 Printer display reads: Memory Overload. 

 Turn the printer Off and On.  Go to your desktop, click Start-Settings-> 
Control Panel->Printers.  Reduce the print resolution to the next lowest 
level.  Set up the report for printing again. 

 Also, 2MB of printer memory is recommended. 

 Error Message - Unable to Write to file named _________. 

 TimeKron cannot write to your hard drive or to the common directory.  The 
most common problem is insufficient disk space.  Free up some disk space.  
This can also occur if your network administrator has restricted your access 
to the common network directory  

 Error Message during installation - Unable to Read _________. 

 This may be a bad CD or a bad CD Drive.  First remove the CD and reboot 
your computer.  Reinsert the CD after you have logged back into Windows  
If the problem continues call Technical Support and report the exact error 
message that appears.  The technical support staff can issue you a new CD. 

 Error Message - Unable to Update Cursor. 

 The user logged on to the network does not have read/write access to the 
common data directory.  This is most likely a network rights issue. 

 Installation or Update Error Message - Can’t change properties of file 
named _________. 

 User requires write access to the Windows directory so that TimeKron can 
automatically update the .DLL files 

 Sometimes the menu options are disabled and I cannot click them. 

 You probably have too many screens open.  Close some screens down. 

 After importing, TimeKron asked me if I wanted to exit and I said no, 
TimeKron exited anyway.  Why? 

 After importing, it is always best to exit and restart TimeKron.  This is to 
ensure that the import was successful. 

 I receive the following error message: 
 “Unable to login to TimeKron.  Base data is incomplete”. 

 The SQL database has been altered into an unusable format.  Most likely a 
critical table has been deleted.  Have your SQL DBA run TimeKron in DB 
Admin mode and use the configuration tools to repair the problems.  If data 
has been lost have your SQL DBA restore a SQL backup. 
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 I receive the following error message: 
 “SQL Command w/ error [SELECT ...]”. 

 The SQL database has been altered into an unusable format.  Have your 
SQL DBA run TimeKron in DB Admin mode and use the configuration tools 
to repair the problems. 

 Some words in TimeKron may be cropped. 

 The font size on the video card is set to large fonts.  Change the font size to 
small fonts 
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AAAppppppeeennndddiiixxx   AAA   –––   SSSaaammmpppllleee   AAASSSPPP   SSScccrrriiipppttt   
 

This appendix includes a Sample ASP script which uses the TimeKron Open Architecture Punching to punch users in and 
out though a web interface. 

Implementing 
To implement the sample script, copy the following 3 files to your web server. 

pathinfo.inc 

processpunch.asp 

default.asp 

The web server will also need to have ODBC access to the SQL Server hosting the TimeKron data.   

pathinfo.inc 
This file includes the ODBC connection string used to communicate with the database.  You will need to modify this file 
according to your own ODBC connection settings. 
<% 
 Dim SQLConnectString 
 SQLConnectString = _ 
  "DRIVER=SQL Server;" & _ 
  "SERVER=MySqlServerName;" & _ 
  "UID=sa;" & _ 
  "PWD=;" & _ 
  "DATABASE=TimeKronSQL;" 
%> 

processpunch.asp 
This script handles most of the work involved in processing the external punches. 

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.0 Transitional//EN"> 

<!--#Include file = "pathinfo.inc"--><HTML><HEAD> 

<META http-equiv=Content-Type content="text/html; charset=unicode"> 

<META content="MSHTML 6.00.2900.2668" name=GENERATOR></HEAD> 

<BODY> 

<FORM Action="processpunch.asp" METHOD="POST" id=form1 name=form1> 

<% 

' Get the BadgeID 

Dim BadgeID 

BadgeID = Request.Form("BadgeID") 

%> 
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SQLConnectString:<br> 

<%=SQLConnectString%><br> 

<br> 

 

BadgeID: <%=BadgeID%><br> 

<br> 

 

<% 

If Request.Form("PunchIn") <> "" Then 

 PunchIn BadgeID 

ElseIf Request.Form("PunchOut") <> "" Then 

 PunchOut BadgeID 

ElseIf Request.Form("PunchWork") <> "" Then 

 PunchWork BadgeID 

End If 

%> 

 

<br> 

BadgeID: <INPUT type="text" id=BadgeID name=BadgeID value="<%=BadgeID%>"><br> 

<br> 

<INPUT type="submit" value="Punch In" id=PunchIn name=PunchIn> 

<INPUT type="submit" value="Punch Out" id=PunchOut name=PunchOut> 

<INPUT type="submit" value="Punch Work" id=PunchWork name=PunchWork> 

</BODY> 

</HTML> 
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<% 

Function PunchIn (BadgeID) 

 Dim PunchCode 

 PunchCode = "I" 

 Response.Write("Processing..." & "<br>") 

 InsertPunchRecord BadgeID, PunchCode 

 Response.Write(BadgeID & " is now punched IN." & "<br>") 

End Function 

 

Function PunchOut (BadgeID) 

 Dim PunchCode 

 PunchCode = "O" 

 Response.Write("Processing..." & "<br>") 

 InsertPunchRecord BadgeID, PunchCode 

 Response.Write(BadgeID & " is now punched OUT." & "<br>") 

End Function 

 

Function PunchWork (BadgeID) 

 Dim PunchCode 

 PunchCode = "W" 

 Response.Write("Processing..." & "<br>") 

 InsertPunchRecord BadgeID, PunchCode 

 Response.Write(BadgeID & " is now punched WORK - (Out of Office)." & "<br>") 

End Function 

 

Function InsertPunchRecord (BadgeID, PunchCode) 

 ' Connect to DB 

 Dim objConn, strQ, strConn 

  

 Set objConn = Server.CreateObject("ADODB.Connection") 

 strConn = SQLConnectString 

  

 objConn.Open strConn 
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 ' Insert Record 

 strQ = _ 

  "INSERT INTO External_Punch ( " &  _ 

    "BadgeID, " &  _ 

    "PunchTime, " &  _ 

    "InOut, " &  _ 

    "PCode, " &  _ 

    "JCode, " &  _ 

    "PunchLoc, " &  _ 

    "UTCOffset " &  _ 

   ") VALUES ( " &  _ 

    SqlPrepChar(BadgeID, 25) & ", " &  _ 

    "GETDATE(), " &  _ 

    SqlPrepChar(PunchCode, 1) & ", " &  _ 

    SqlPrepChar("PCODE", 20) & ", " &  _ 

    SqlPrepChar("JCODE", 20) & ", " &  _ 

    SqlPrepChar("asp:TestScript", 30) & ", " &  _ 

    "NULL " &  _ 

   ") " 

 objConn.Execute strQ 

  

 ' Disconnect from DB 

 objConn.Close 

 Set objConn = Nothing 

  

End Function 

 

Function SqlPrepChar (cValue, nLength) 

    If nLength > 0 Then 

  ' Trim Result 

  cValue = Mid(cValue, 1, nLength) 

    End If 

 SqlPrepChar = "'" & Trim(Replace(cValue, "'", "''")) & "'" 

End Function 
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%> 

 

default.asp 
This script provides a generic interface for entering in punch data.  You can rename this script to something other than 
“default.asp” if you choose.   

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.0 Transitional//EN"> 

<!--#Include file = "pathinfo.inc"--><HTML><HEAD> 

<META http-equiv=Content-Type content="text/html; charset=unicode"> 

<META content="MSHTML 6.00.2900.2668" name=GENERATOR></HEAD> 

<BODY> 

<FORM Action="processpunch.asp" METHOD="POST"> 

SQLConnectString:<br> 

<%=SQLConnectString%><br> 

<br> 

BadgeID: <INPUT type="text" id=BadgeID name=BadgeID><br> 

<br> 

<INPUT type="submit" value="Punch In" id=PunchIn name=PunchIn> 

<INPUT type="submit" value="Punch Out" id=PunchOut name=PunchOut> 

<INPUT type="submit" value="Punch Work" id=PunchWork name=PunchWork> 

</BODY> 

</HTML> 

Testing the Script 
The External Punch System first must be enabled through the Super Administrator options.  See Chapter 3 – Getting 
Started.  Once you have copied the 3 scripts to your web page and configured them for your ODBC connection you can 
test the script.  Browse to default.asp (or whatever you have changed the filename to).  Enter in the Badge ID of a 
TimeKron employee as seen on the Employee Information page.  Click on “Punch In”.  If everything is configured 
correctly, the employee should now be punched in.  Open TimeKron and view the In/Out board to verify this. 
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Customizing the Script 
The key statement of the script is… 

' Insert Record  

strQ = _ 

"INSERT INTO External_Punch ( " & _ 

"BadgeID, " & _ 

"PunchTime, " & _ 

"InOut, " & _  

"PCode, " & _  

"JCode, " & _  

"PunchLoc, " & _  

"UTCOffset " & _  

") VALUES ( " & _  

SqlPrepChar(BadgeID, 25) & ", " & _  

"GETDATE(), " & _  

SqlPrepChar(PunchCode, 1) & ", " & _  

SqlPrepChar("PCODE", 20) & ", " & _  

SqlPrepChar("JCODE", 20) & ", " & _  

SqlPrepChar("asp:TestScript", 30) & ", " & _  

"NULL " & _  

") "  

 

objConn.Execute strQ 

 

Here are the Field Definitions for the SQL INSERT Statement 

BadgeID  

the BadgeID assigned to the Employee  

Required  

Character(25)  

Example – ‘00005’  

PunchTime  

the timestamp of the Punch  

Required  
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DateTime  

Example – ‘2005-11-18 10:51:34’  

InOut  

the type of Punch  

Required  

Character(1)  

Example – ‘I’ = In, ‘O’ = Out, ‘W’ = Working out of office  

PCode  

the Project code associated with the punch  

Not Required  

Character(20)  

Example – ‘M56’  

JCode  

the Job code associated with the punch  

Not Required  

Character(20)  

Example – ‘SUPP’  

PunchLoc  

a string that uniquely defines the device that the punch came from  

Not Required but Highly recommended  

Character(30)  

Example – ‘ACT_FP:Front Desk’  

UTCOffset  

the time zone differential between the time clock and GMT in seconds  

Not Required (useful for companies running over a WAN spanning multiple time zones)  

Integer  

Example – NULL for unknown, -14400 for Eastern Standard Time, -18000 for Eastern Daylight Savings Time  

 

You can also extract some basic information from the Database with the statement: 

SELECT * FROM View_InOut 

The Dataset will include Employee Name, BadgeID, Department, Current In/Out Status, Employee Email, and some other 
1:1 employee information.  Note the update of In/Out status in the View_InOut table is not immediate.  It will not be 
updated until TimeKron has successfully processed the external punch. 
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All rights reserved. 
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authorized users concurrently operating the program is subject to purchase license. 
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users set forth by the product. 
 

Governing Law 
The laws of the Commonwealth of Virginia shall govern this agreement. 
 

Disclaimer of Warranty 
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND 
WITHOUT WARRANTIES AS TO PERFORMANCE OF MERCHANTABILITY OR 
ANY OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED.  In particular, 
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NO WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE CAN BE OFFERED. 
 
ANY LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY TO PRODUCT 
REPLACEMENT. 
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